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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

•  Thorough knowledge of basic MRP II and accounting concepts.

•  Working experience with cost accounting activities in various different
manufacturing environments.

Prerequisites

•  Oracle Inventory Release 11

•  Oracle Purchasing Release 11

•  Oracle Bills of Material and Engineering Release 11 (if products are
installed at your site)

•  Oracle Work In Process Release 11 (if products are installed at your site)

•  Oracle Planning Release 11

•  Oracle General Ledger Release 11

•  R11i Costing Setup and Implementation

•  R11i Cost Information

•  R11i Cost Rollup

How This Course Is Organized

R11i Standard Costing is an instructor-led course featuring lecture and hands-on
exercises.  Online demonstrations and written practice sessions reinforce the
concepts and skills introduced.
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Related Publications

Oracle Publications

Title Part Number

Oracle Inventory User’s Guide Release 11i A58270-01

Oracle Purchasing User’s Guide Release 11i A82912-01

Oracle Bill of Materials User’s Guide Release 11i A75087-01

Oracle Engineering User’s Guide Release 11i A75090-01

Oracle Work In Process User’s Guide Release 11i A75101-01

Oracle Cost Management User’s Guide Release 11i A75088-01

Oracle General Ledger User’s Guide Release 11i A82850-01

Additional Publications

•  System release bulletins

•  Installation and user’s guides

•  read.me files

•  Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Standard Costing Table of Contents
ix

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab

(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Standard Costing Table of Contents
x

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.

3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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Standard CostingStandard Costing

Accounting for Inventory Transactions
for Standard Costing

Accounting for Inventory Transactions
for Standard Costing
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ObjectivesObjectives

After completing this lesson, you should be able to:
• Set up standard costing
• Account for inventory transactions in standard

costing

After completing this lesson, you should be able to:
• Set up standard costing
• Account for inventory transactions in standard

costing

Ship goodsShip goodsReceive goodsReceive goodsPurchasesPurchases

IntransitIntransit AdjustmentsAdjustmentsDirectDirect
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AgendaAgenda

• Overview of Standard Costing
• Setting Up Standard Costing
• Accounting for Inventory Transactions in Standard

Costing

• Overview of Standard  Costing
•• Setting Up Standard CostingSetting Up Standard Costing
•• Accounting for Inventory Transactions in StandardAccounting for Inventory Transactions in Standard

CostingCosting
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Transactions
• Inventory purchasing transactions
• Expense purchasing transactions using month-end

accruals
• Expense purchasing transactions using online

accruals
• Miscellaneous transactions
• Inter-organization transfers using intransit inventory
• Direct inter-organization transfers
• Customer shipment and return transactions
• Adjustment transactions
• Internal requisitions

Transactions
• Inventory purchasing transactions
• Expense purchasing transactions using month-end

accruals
• Expense purchasing transactions using online

accruals
• Miscellaneous transactions
• Inter-organization transfers using intransit inventory
• Direct inter-organization transfers
• Customer shipment and return transactions
• Adjustment transactions
• Internal requisitions
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FinancialFinancial
transactionstransactionsAudit trailAudit trail

QuantityQuantity
movementsmovements

Recording Quantity Movements
• The system records quantity movements as

financial transactions.

Recording Quantity Movements
• The system records quantity movements as

financial transactions.
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Minimizing Accounting Entries
• The system summarizes all accounting entries for

the inventory subinventories by a unique cost
element account.

Subinventory Transfer
• The system records two transactions for the

quantity movement, but only one transaction
generates accounting entries.

Minimizing Accounting Entries
• The system summarizes all accounting entries for

the inventory subinventories by a unique cost
element account.

Subinventory Transfer
• The system records two transactions for the

quantity movement, but only one transaction
generates accounting entries.
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Accounting Information
• You can create separate accounting entries for

material and material overhead costs.
• When the subinventory elemental accounts are

unique, the accounting entries carry cost element
information.

• All standard cost accounting entries reference the
last cost update.

• All transactions for items with zero cost have
accounting information.

• All accounting entries tell you the purpose for the
accounting entry. This is called the accounting type.

Accounting Information
• You can create separate accounting entries for

material and material overhead costs.
• When the subinventory elemental accounts are

unique, the accounting entries carry cost element
information.

• All standard cost accounting entries reference the
last cost update.

• All transactions for items with zero cost have
accounting information.

• All accounting entries tell you the purpose for the
accounting entry. This is called the accounting type.
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Journal Source
• For both inventory and work-in-process entries,

the journal source in Oracle General Ledger is
Oracle Inventory.

Journal Source
• For both inventory and work-in-process entries,

the journal source in Oracle General Ledger is
Oracle Inventory.

OracleOracle
InventoryInventory
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Describing the Relationship Betweenthe Relationship Between
Transactions and Cost ManagementTransactions and Cost Management

Charging Material Transactions at Standard Cost
• You perform inventory transactions and use

standard costs to value transactions.
• You issue items from inventory to jobs and return

components from a job back to inventory at
standard cost.

Charging Material Transactions at Standard Cost
• You perform inventory transactions and use

standard costs to value transactions.
• You issue items from inventory to jobs and return

components from a job back to inventory at
standard cost.
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Describing the Relationship Betweenthe Relationship Between
Transactions and Cost ManagementTransactions and Cost Management

Applying Material Overhead
• The system includes material overhead type costs

(receiving, stocking, material movement, and
handling) in inventory valuation.

• The system applies predefined material overhead
amounts to items.

Charging Assembly Completions at Standard Cost
• The system uses standard cost to value completed

assemblies.
• When you move completed assemblies from WIP

to a subinventory, the system reduces WIP and
charges inventory for the amount of the standard
cost.

Applying Material Overhead
• The system includes material overhead type costs

(receiving, stocking, material movement, and
handling) in inventory valuation.

• The system applies predefined material overhead
amounts to items.

Charging Assembly Completions at Standard Cost
• The system uses standard cost to value completed

assemblies.
• When you move completed assemblies from WIP

to a subinventory, the system reduces WIP and
charges inventory for the amount of the standard
cost.
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Describing the Relationship Betweenthe Relationship Between
Transactions and Cost ManagementTransactions and Cost Management

Cost Control Attributes
• With standard costing, Oracle Cost Management

uses two item attributes, Costing Enabled and the
Inventory Asset Value, as well as the Asset
Subinventory designation on the subinventory to
determine how to value the transactions.

Cost Control Attributes
• With standard costing, Oracle Cost Management

uses two item attributes, Costing Enabled and the
Inventory Asset Value, as well as the Asset
Subinventory designation on the subinventory to
determine how to value the transactions.

Cost controlsCost controls
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Describing the Relationship Betweenthe Relationship Between
Transactions and Cost ManagementTransactions and Cost Management

Costing Enabled Attribute
• Checked means the item may be costed and is

visible on all reports and inquiries.
• Unchecked means the item is not used for any

costing purpose. It does not appear on any cost
inquiry or report, including the following:

• Inventory Value report
– Item Cost reports
– Item Cost inquiries

• You cannot change this item attribute if there is a
quantity onhand.

Costing Enabled Attribute
• Checked means the item may be costed and is

visible on all reports and inquiries.
• Unchecked means the item is not used for any

costing purpose. It does not appear on any cost
inquiry or report, including the following:

• Inventory Value report
– Item Cost reports
– Item Cost inquiries

• You cannot change this item attribute if there is a
quantity onhand.
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Describing the Relationship Between
Transactions and Cost Management

Describing the Relationship Betweenthe Relationship Between
Transactions and Cost ManagementTransactions and Cost Management

Inventory Asset Value
• Checked means the item is an asset and can have

a cost.
• Unchecked means the item is an inventory

expense item and cannot have a cost.
• Each item may have a different asset value flag

status by cost type.
• Do not confuse inventory expense items with

expense destination types in Oracle Purchasing.

Inventory Asset Value
• Checked means the item is an asset and can have

a cost.
• Unchecked means the item is an inventory

expense item and cannot have a cost.
• Each item may have a different asset value flag

status by cost type.
• Do not confuse inventory expense items with

expense destination types in Oracle Purchasing.
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Describing the Relationship Between
Transactions and Cost Management

Describing the Relationship Betweenthe Relationship Between
Transactions and Cost ManagementTransactions and Cost Management

Asset Inventory
• If checked, and the attributes named above are

checked, it means that the item is an asset item
and is carried on the balance sheet as an asset.

Asset Inventory
• If checked, and the attributes named above are

checked, it means that the item is an asset item
and is carried on the balance sheet as an asset.
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Review QuestionReview Question

When you apply material overhead, the system
includes material overhead type costs (receiving,
stocking, material movement, and handling) in
inventory valuation.
1. True
2. False

When you apply material overhead, the system
includes material overhead type costs (receiving,
stocking, material movement, and handling) in
inventory valuation.
1. True
2. False
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Review QuestionReview Question

When you apply material overhead, the system
includes material overhead type costs (receiving,
stocking, material movement, and handling) in
inventory valuation.
1. True
2. False

When you apply material overhead, the system
includes material overhead type costs (receiving,
stocking, material movement, and handling) in
inventory valuation.
1. True
2. False2. False



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for Inventory Transactions for Standard Costing
Chapter 1 - Page 18

Agenda

Copyright   Oracle Corporation, 2000. All rights reserved.
®

AgendaAgenda

• Overview of Standard Costing
• Setting Up Standard Costing
• Accounting for Inventory Transactions in Standard

Costing

•• Overview of Standard CostingOverview of Standard Costing
• Setting Up Standard Costing
•• Accounting for Inventory Transactions in StandardAccounting for Inventory Transactions in Standard

CostingCosting
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Setting Up Standard CostingSetting Up Standard Costing

Costing Method in Organization Parameters
Using Oracle Manufacturing, the way you define your
inventory organization affects how you are able to
collect costs.
If you want to use standard costing, you must define
the costing method of the inventory organization as
standard. Once you assign items to the organization,
you cannot change the costing method of the
organization.

Costing Method in Organization Parameters
Using Oracle Manufacturing, the way you define your
inventory organization affects how you are able to
collect costs.
If you want to use standard costing, you must define
the costing method of the inventory organization as
standard. Once you assign items to the organization,
you cannot change the costing method of the
organization.
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Setting Up Standard CostingSetting Up Standard Costing

Use the Organization Parameters window to enter:
• The costing method as standard
Use the Organization Parameters window to enter:
• The costing method as standard

(N) INV Setup > Organizations > Parameters (T) Costing
Information

(N) INV Setup > Organizations > Parameters (T) Costing
Information

Help: Oracle Manufacturing Applications >Oracle Inventory > Setting
Up > Inventory Structure >
Defining Organization Parameters > Defining Costing Information
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Setting Up Standard CostingSetting Up Standard Costing

Item Cost Controls
• The control level determines how item costs are

maintained within an Inventory organization.
• You cannot share costs across organizations if

you have Bill of Materials installed since you
cannot share resource costs across organizations.

Item Cost Controls
• The control level determines how item costs are

maintained within an Inventory organization.
• You cannot share costs across organizations if

you have Bill of Materials installed since you
cannot share resource costs across organizations.

Cost controlsCost controls
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Setting Up Standard CostingSetting Up Standard Costing

Use the Item Attribute Controls window to set:
• The costing group item attributes to “Org level”
Use the Item Attribute Controls window to set:
• The costing group item attributes to “Org level”

(N) INV Setup > Items > Attribute Controls(N) INV Setup > Items > Attribute Controls

Help: Oracle Manufacturing Applications >Oracle Inventory > Items >
Master Level vs Organization Level
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AgendaAgenda

• Overview of Standard Costing
• Setting Up Standard Costing
• Accounting for Inventory Transactions in Standard

Costing

•• Overview of Standard CostingOverview of Standard Costing
•• Setting Up Standard CostingSetting Up Standard Costing
• Accounting for Inventory Transactions in Standard

Costing
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Transaction Account ReferenceTransaction Account Reference

Asset Versus Expense Accounting
Standard Costing

Asset Versus Expense Accounting
Standard Costing

TransactionTransaction

Asset ItemAsset Item Expense ItemExpense Item

Asset
Subinventory

Asset
Subinventory

Expense
Subinventory

Expense
Subinventory

Asset
Subinventory

Asset
Subinventory

Expense
Subinventory

Expense
Subinventory

PO ReceiptPO Receipt Subinventory
valuation
accounts @
standard cost

Subinventory
valuation
accounts @
standard cost

Subinventory
expense
account @ PO
price

Subinventory
expense
account @ PO
price

Subinventory
expense
account @ PO
price

Subinventory
expense
account @ PO
price

Subinventory
expense
account @ PO
price

Subinventory
expense
account @ PO
price

PO ReturnPO Return Subinventory
valuation
accounts @
standard cost

Subinventory
valuation
accounts @
standard cost

Subinventory
expense
account @ PO
price

Subinventory
expense
account @ PO
price

Subinventory
expense
account @ PO
price

Subinventory
expense
account @ PO
price

Subinventory
expense
account @ PO
price

Subinventory
expense
account @ PO
price



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for Inventory Transactions for Standard Costing
Chapter 1 - Page 25

Transaction Account Reference

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Transaction Account ReferenceTransaction Account Reference

Asset Versus Expense Accounting
Standard Costing

Asset Versus Expense Accounting
Standard Costing

TransactionTransaction

Asset ItemAsset Item

Asset
Subinventory

Asset
Subinventory

Expense ItemExpense Item

Expense
Subinventory

Expense
Subinventory

Asset
Subinventory

Asset
Subinventory

Expense
Subinventory

Expense
Subinventory

Interorg
Transfers
Direct

Interorg
Transfers
Direct

From asset
subinventory:
Subinventory
valuation
accounts @
standard cost
From expense
subinventory:
Not allowed

From asset
subinventory:
Subinventory
valuation
accounts @
standard cost
From expense
subinventory:
Not allowed

From asset
subinventory:
Subinventory
expense
account @
standard cost
From expense
subinventory:
No accounting
for the item cost
but transfer
credit and
freight charged
to subinventory
expense
account

From asset
subinventory:
Subinventory
expense
account @
standard cost
From expense
subinventory:
No accounting
for the item cost
but transfer
credit and
freight charged
to subinventory
expense
account

No accountingNo accounting No accountingNo accounting
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Asset Versus Expense Accounting
Standard Costing

Asset Versus Expense Accounting
Standard Costing

TransactionTransaction

Asset ItemAsset Item Expense ItemExpense Item

Asset
Subinventory

Asset
Subinventory

Expense
Subinventory

Expense
Subinventory

Asset
Subinventory

Asset
Subinventory

Expense
Subinventory

Expense
Subinventory

Interorg

Transfers
Intransit

Interorg

Transfers
Intransit

From asset
subinventory:
Subinventory
valuation
accounts @
standard cost
From expense
subinventory:
Not allowed

From asset
subinventory:
Subinventory
valuation
accounts @
standard cost
From expense
subinventory:
Not allowed

From asset
subinventory:
Subinventory
expense
account @
standard cost
From expense
subinventory:
Not allowed

From asset
subinventory:
Subinventory
expense
account @
standard cost
From expense
subinventory:
Not allowed

No accountingNo accounting No accountingNo accounting

Misc. IssueMisc. Issue Subinventory
valuation
accounts @
standard cost

Subinventory
valuation
accounts @
standard cost

No accountingNo accounting No accountingNo accounting No accountingNo accounting

Misc.
Receipt

Misc.
Receipt

Subinventory
valuation
accounts @
standard cost

Subinventory
valuation
accounts @
standard cost

No accountingNo accounting No accountingNo accounting No accountingNo accounting

Transaction Account ReferenceTransaction Account Reference
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Transaction Account ReferenceTransaction Account Reference
Asset Versus Expense Accounting

Standard Costing
Asset Versus Expense Accounting

Standard Costing

TransactionTransaction

Asset ItemAsset Item Expense ItemExpense Item

Asset
Subinventory

Asset
Subinventory

Expense
Subinventory

Expense
Subinventory

Asset
Subinventory

Asset
Subinventory

Expense
Subinventory

Expense
Subinventory

Subinv
Transfer

Subinv
Transfer

From asset
subinventory:
Subinventory
valuation
accounts @
standard cost
From expense
subinventory:
Not allowed

From asset
subinventory:
Subinventory
valuation
accounts @
standard cost
From expense
subinventory:
Not allowed

From asset
subinventory:
Subinventory
expense
account @
standard cost
From expense
subinventory:
No accounting

From asset
subinventory:
Subinventory
expense
account @
standard cost
From expense
subinventory:
No accounting

No accountingNo accounting No accountingNo accounting

SO
Shipment

SO
Shipment

Subinventory
valuation
accounts @
standard cost

Subinventory
valuation
accounts @
standard cost

No accountingNo accounting No accountingNo accounting No accountingNo accounting

SO
Customer
Return

SO
Customer
Return

Subinventory
valuation
accounts @
standard cost

Subinventory
valuation
accounts @
standard cost

No accountingNo accounting No accountingNo accounting No accountingNo accounting
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Transaction Account ReferenceTransaction Account Reference
Asset Versus Expense Accounting

Standard Costing
Asset Versus Expense Accounting

Standard Costing

TransactionTransaction

Asset ItemAsset Item Expense ItemExpense Item

Asset
Subinventory

Asset
Subinventory

Expense
Subinventory

Expense
Subinventory

Asset
Subinventory

Asset
Subinventory

Expense
Subinventory

Expense
Subinventory

WIP IssueWIP Issue Subinventory
valuation
accounts @
standard cost

Subinventory
valuation
accounts @
standard cost

Not allowedNot allowed No accountingNo accounting No accountingNo accounting

WIP
Completion

WIP
Completion

To asset
subinventory:
Subinventory
valuation
accounts @
standard cost
To expense
subinventory:
Not allowed

To asset
subinventory:
Subinventory
valuation
accounts @
standard cost
To expense
subinventory:
Not allowed

Not allowedNot allowed No accountingNo accounting No accountingNo accounting

PI/Cycle
Count

PI/Cycle
Count

Subinventory
valuation
accounts @
standard cost

Subinventory
valuation
accounts @
standard cost

No accountingNo accounting No accountingNo accounting No accountingNo accounting
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Inventory TransactionsInventory Transactions

Use the Material Transaction Distributions window to:
• Review accounting distributions of transactions

(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions

Use the Material Transaction Distributions window to:
• Review accounting distributions of transactions

(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Viewing Material Transaction Distributions
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Inventory Purchasing TransactionsInventory Purchasing Transactions

ReceiveReceive
goodsgoods

PurchasesPurchases AccountAccount
definitiondefinition

InspectionInspectionInventoryInventory
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Inventory Purchasing TransactionsInventory Purchasing Transactions

Use the Organization Parameters window to define
receiving accounts, including the following:
• Purchase price variance account
• Invoice price variance account
• Inventory AP accrual account
(N) INV Setup > Organizations > Parameters (T) Other Accounts

Use the Receiving Options window to define:
• The Receiving Inspection account
(N) PUR Setup > Organizations > Receiving Options

Use the Organization Parameters window to define
receiving accounts, including the following:
• Purchase price variance account
• Invoice price variance account
• Inventory AP accrual account
(N) INV Setup > Organizations > Parameters (T) Other Accounts

Use the Receiving Options window to define:
• The Receiving Inspection account
(N) PUR Setup > Organizations > Receiving Options

Help: Oracle Manufacturing Applications >Oracle Inventory > Setting
Up > Inventory Structure >
Defining Organization Parameters > Defining Other Accounts
Help: Oracle Manufacturing Applications >Oracle Purchasing >
Setting Up > Purchasing Options > Defining Receiving Options
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Transaction Entry

• Enter inventory purchasing transactions by using
transaction entry screens in the following Oracle
Applications:
– Inventory, Purchasing, or Accounts Payable

• View transactions online and review transactions
in their respective modules:
– Inventory transactions in Inventory
– Purchasing transactions in Purchasing
– Accounts Payable (AP) transactions in AP

Transaction Entry

• Enter inventory purchasing transactions by using
transaction entry screens in the following Oracle
Applications:
– Inventory, Purchasing, or Accounts Payable

• View transactions online and review transactions
in their respective modules:
– Inventory transactions in Inventory
– Purchasing transactions in Purchasing
– Accounts Payable (AP) transactions in AP
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Inventory Purchasing TransactionsInventory Purchasing Transactions

Oracle Payables
• Introduces a new accounting model to support the

creation and retention of accounting entries in the
Payables subledger

Payables Transfer to General Ledger program
• Creates accounting for Payables transactions
• Pulls information out of transaction tables, creates

accounting entries, and places them in the gl
interface. From there the general ledger process
Journal Import creates journal entries and imports
them as unposted journal entries into Oracle
General Ledger.

Oracle Payables
• Introduces a new accounting model to support the

creation and retention of accounting entries in the
Payables subledger

Payables Transfer to General Ledger program
• Creates accounting for Payables transactions
• Pulls information out of transaction tables, creates

accounting entries, and places them in the gl
interface. From there the general ledger process
Journal Import creates journal entries and imports
them as unposted journal entries into Oracle
General Ledger.
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Inventory Purchasing TransactionsInventory Purchasing Transactions

One Step Receiving: Dock to stock in one transaction
• Transaction and entry recorded in purchasing for

the receipt (dock) and transaction and entry
recorded in inventory for the delivery (stock).

• There is not an option to inspect and the receipt
routing will be derived from the purchase order
line as direct. The resulting transactions are
always a receipt and then a delivery.

One Step Receiving: Dock to stock in one transaction
• Transaction and entry recorded in purchasing for

the receipt (dock) and transaction and entry
recorded in inventory for the delivery (stock).

• There is not an option to inspect and the receipt
routing will be derived from the purchase order
line as direct. The resulting transactions are
always a receipt and then a delivery.
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To receive material from a vendor in one step, use
the Receipts window. The resulting transactions are
always a receipt and then a delivery.
Use the Receipts window to:
• Receive material from a vendor directly to inventory
(N) INV Transactions > Receiving > Receipts

To receive material from a vendor in one step, use
the Receipts window. The resulting transactions are
always a receipt and then a delivery.
Use the Receipts window to:
• Receive material from a vendor directly to inventory
(N) INV Transactions > Receiving > Receipts

Help: Oracle Manufacturing Applications >Oracle Purchasing >
Receiving > Receiving Transactions
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Two Step Receiving: Dock in one transaction and
stock in a separate transaction.
• Transaction and entry recorded in purchasing for

the receipt.
• A separate transaction on a separate screen

records the transaction and entry in inventory for
the delivery.

• There is not an option to inspect and the receipt
routing will be derived from the purchase order
line as standard.

Two Step Receiving: Dock in one transaction and
stock in a separate transaction.
• Transaction and entry recorded in purchasing for

the receipt.
• A separate transaction on a separate screen

records the transaction and entry in inventory for
the delivery.

• There is not an option to inspect and the receipt
routing will be derived from the purchase order
line as standard.
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To receive material from a vendor in two steps, use
the Receipts and the Receiving Transactions windows.
The resulting transactions are always a receipt and
then a delivery.
Use the Receipts window to:
• Receive material from a vendor to receiving
(N) INV Transactions > Receiving > Receipts
Use the Receiving Transactions window to:
• Move material from receiving to inventory
(N) INV Transactions > Receiving > Receiving Transactions

To receive material from a vendor in two steps, use
the Receipts and the Receiving Transactions windows.
The resulting transactions are always a receipt and
then a delivery.
Use the Receipts window to:
• Receive material from a vendor to receiving
(N) INV Transactions > Receiving > Receipts
Use the Receiving Transactions window to:
• Move material from receiving to inventory
(N) INV Transactions > Receiving > Receiving Transactions

Help: Oracle Manufacturing Applications > Oracle Purchasing  >
Receiving > Receiving Transactions
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Inspection: Dock in one transaction
• Transaction and entry recorded in purchasing for

the receipt.
• Inspection is completed next.  After the item is

inspected, the delivery into stock occurs and the
transaction and entry is recorded.  The receipt
routing on the purchase order line will say
inspection.

• There is not an entry recorded during the
inspection.  It is considered "on the dock".

Inspection: Dock in one transaction
• Transaction and entry recorded in purchasing for

the receipt.
• Inspection is completed next.  After the item is

inspected, the delivery into stock occurs and the
transaction and entry is recorded.  The receipt
routing on the purchase order line will say
inspection.

• There is not an entry recorded during the
inspection.  It is considered "on the dock".
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Receipts to Receiving and Delivery to Inventory
• Oracle Purchasing uses the quantity received and

the purchase order price to update the Inventory AP
Accrual accounts, Receiving Inspection accounts
and Subinventory accounts. These accounting
entries always occur, regardless of one- or two-step
receiving.

• Oracle Purchasing uses the purchase order cost,
converted into functional currency using either the
purchase order exchange rate or the receiving
exchange rate (depending on the matching option
recorded on the purchase order shipment line).

Receipts to Receiving and Delivery to Inventory
• Oracle Purchasing uses the quantity received and

the purchase order price to update the Inventory AP
Accrual accounts, Receiving Inspection accounts
and Subinventory accounts. These accounting
entries always occur, regardless of one- or two-step
receiving.

• Oracle Purchasing uses the purchase order cost,
converted into functional currency using either the
purchase order exchange rate or the receiving
exchange rate (depending on the matching option
recorded on the purchase order shipment line).
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Oracle Inventory
Use the Material Transaction Distributions window to:
• Review accounting distributions of inventory

purchasing transactions once you have received
the goods

(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions

Oracle Inventory
Use the Material Transaction Distributions window to:
• Review accounting distributions of inventory

purchasing transactions once you have received
the goods

(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Viewing Material Transaction Distributions
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Review QuestionReview Question

Oracle Purchasing uses the purchase order cost,
converted into functional currency using either the
purchase order exchange rate or the receiving
exchange rate (depending on the matching option
recorded on the purchase order shipment line).
1. True
2. False

Oracle Purchasing uses the purchase order cost,
converted into functional currency using either the
purchase order exchange rate or the receiving
exchange rate (depending on the matching option
recorded on the purchase order shipment line).
1. True
2. False
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Review QuestionReview Question

Oracle Purchasing uses the purchase order cost,
converted into functional currency using either the
purchase order exchange rate or the receiving
exchange rate (depending on the matching option
recorded on the purchase order shipment line).
1. True
2. False

Oracle Purchasing uses the purchase order cost,
converted into functional currency using either the
purchase order exchange rate or the receiving
exchange rate (depending on the matching option
recorded on the purchase order shipment line).
1. True
2. False2. False
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Expense Purchasing TransactionsExpense Purchasing Transactions

ExpenseExpense
purchasespurchases

Accruals uponAccruals upon
receiptreceipt

Accruals atAccruals at
period endperiod end
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Expense Accruals
• Accruing Expenses at Period End

– No accounting entries are made at the time of
PO receipt. You can run the Purchasing
Receipt Accrual-Period End process to debit
the expenses and credit the expense AP
accrual account.

• Accruing Expenses upon Receipt
– The PO receipt transaction debits the expense

and credits the expense AP accrual account.

Expense Accruals
• Accruing Expenses at Period End

– No accounting entries are made at the time of
PO receipt. You can run the Purchasing
Receipt Accrual-Period End process to debit
the expenses and credit the expense AP
accrual account.

• Accruing Expenses upon Receipt
– The PO receipt transaction debits the expense

and credits the expense AP accrual account.
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Use the Purchasing Options window to:
• Choose to accrue expense items at period end or

upon receipt
• Define the Expense AP Accrual account
(N) PUR Setup > Organizations > Purchasing Options

Use the Purchasing Options window to:
• Choose to accrue expense items at period end or

upon receipt
• Define the Expense AP Accrual account
(N) PUR Setup > Organizations > Purchasing Options

Help: Oracle Manufacturing Applications >Oracle Purchasing >
Setting Up > Purchasing Options > Defining Purchasing Options
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Review QuestionReview Question

Using the Purchasing Options window, you can
choose to accrue expense items at period end or
upon receipt.
1. True
2. False

Using the Purchasing Options window, you can
choose to accrue expense items at period end or
upon receipt.
1. True
2. False
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Review QuestionReview Question

Using the Purchasing Options window, you can
choose to accrue expense items at period end or
upon receipt.
1. True
2. False

Using the Purchasing Options window, you can
choose to accrue expense items at period end or
upon receipt.
1. True
2. False2. False
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Subinventory Transactions
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Subinventory TransactionsSubinventory Transactions

Oracle Inventory decreases the quantity of the item in
one subinventory and increases it in another
subinventory; inventory values stay the same.
Use the Subinventory Transfer window to move
material from:
• One subinventory to another subinventory in the

same inventory organization.
– Asset subinventory to expense subinventory
– Expense subinventory to asset subinventory
– Asset subinventory to expense subinventory
– Expense subinventory to asset subinventory

(N) INV Transactions > Subinventory Transfer

Oracle Inventory decreases the quantity of the item in
one subinventory and increases it in another
subinventory; inventory values stay the same.
Use the Subinventory Transfer window to move
material from:
• One subinventory to another subinventory in the

same inventory organization.
– Asset subinventory to expense subinventory
– Expense subinventory to asset subinventory
– Asset subinventory to expense subinventory
– Expense subinventory to asset subinventory

(N) INV Transactions > Subinventory Transfer

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Transferring Between Subinventories
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Miscellaneous Inventory TransactionsMiscellaneous Inventory Transactions

Use the Miscellaneous Transaction window to:
• Issue material from a subinventory to a general

ledger account or to an account alias.
• Receive material to a subinventory from a general

ledger account or from an account alias.
• Transfer onhand quantities into Oracle

Applications from legacy systems and establish
standard costs via the same transactions.

(N) INV Transactions > Miscellaneous Transaction

Use the Miscellaneous Transaction window to:
• Issue material from a subinventory to a general

ledger account or to an account alias.
• Receive material to a subinventory from a general

ledger account or from an account alias.
• Transfer onhand quantities into Oracle

Applications from legacy systems and establish
standard costs via the same transactions.

(N) INV Transactions > Miscellaneous Transaction

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Performing Miscellaneous Transactions
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Miscellaneous Inventory Transactions
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Miscellaneous Inventory TransactionsMiscellaneous Inventory Transactions

Issue from Stores
• Oracle Inventory decreases the quantity of the

item in the subinventory and locator that you
specify in the transaction window, changing the
appropriate inventory values.

Receipt into stores
• Oracle Inventory increases the quantity of the item

in the subinventory and locator that you specify in
the transaction window, changing the appropriate
inventory values.

(N) INV Transactions > Miscellaneous Transaction

Issue from Stores
• Oracle Inventory decreases the quantity of the

item in the subinventory and locator that you
specify in the transaction window, changing the
appropriate inventory values.

Receipt into stores
• Oracle Inventory increases the quantity of the item

in the subinventory and locator that you specify in
the transaction window, changing the appropriate
inventory values.

(N) INV Transactions > Miscellaneous Transaction

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Performing Miscellaneous Transactions
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Subinventory Transactions and Miscellaneous
Inventory Transactions
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Subinventory Transactions and
Miscellaneous Inventory Transactions

Subinventory Transactions and
Miscellaneous Inventory Transactions

Oracle Inventory
Use the Material Transaction Distributions window to
review accounting distributions of:
• Subinventory transfers
• Miscellaneous transactions

(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions

Oracle Inventory
Use the Material Transaction Distributions window to
review accounting distributions of:
• Subinventory transfers
• Miscellaneous transactions

(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Viewing Material Transaction Distributions



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for Inventory Transactions for Standard Costing
Chapter 1 - Page 52

Review Question

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Review QuestionReview Question

You use miscellaneous transactions to:
• Issue material from a subinventory to a general

ledger account or to an account alias.
• Receive material to a subinventory from a general

ledger account or from an account alias.
1. True
2. False

You use miscellaneous transactions to:
• Issue material from a subinventory to a general

ledger account or to an account alias.
• Receive material to a subinventory from a general

ledger account or from an account alias.
1. True
2. False
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Review QuestionReview Question

You use miscellaneous transactions to:
• Issue material from a subinventory to a general

ledger account or to an account alias.
• Receive material to a subinventory from a general

ledger account or from an account alias.
1. True
2. False

You use miscellaneous transactions to:
• Issue material from a subinventory to a general

ledger account or to an account alias.
• Receive material to a subinventory from a general

ledger account or from an account alias.
1. True
2. False2. False
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Inter-organization TransfersInter-organization Transfers

Receive goodsReceive goods

IntransitIntransit

BostonBoston
ManufacturingManufacturing

Transfer goodsTransfer goods

Ship goodsShip goods

ChicagoChicago
ManufacturingManufacturing

FromFrom

FromFromToTo

ToTo

DirectDirect
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Inter-organization Transfers
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Inter-organization TransfersInter-organization Transfers

Accounting Flows
• Accounting flows for inter-organization transfers

vary depending on whether you transfer material
directly from one organization to another or
transfer material through intransit inventory.

Shipping Information
Use the Inter-Organization Shipping Network window
to define:
• The direct or intransit shipment type for each

shipping and receiving organization relationship.
(N) INV Setup > Organizations > Shipping Networks

Accounting Flows
• Accounting flows for inter-organization transfers

vary depending on whether you transfer material
directly from one organization to another or
transfer material through intransit inventory.

Shipping Information
Use the Inter-Organization Shipping Network window
to define:
• The direct or intransit shipment type for each

shipping and receiving organization relationship.
(N) INV Setup > Organizations > Shipping Networks

Help: Oracle Manufacturing Applications >Oracle Inventory > Setting
Up > Transaction Setup >
Inter-Organization Shipping Network
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Direct Inter-organization Transfers
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Direct Inter-organization TransfersDirect Inter-organization Transfers

Direct Organization Transfer
• Decreases the quantity of an item in one

organization and increases it in another
organization, performing both the issue and the
receipt transactions

• Decreases inventory values in the sending
organization and increases inventory values in the
receiving organization

• Always credits transfer and freight charges to the
shipping organization

• Does not make entries for direct inter-organization
transfers of expense items

• Does not go through intransit inventory

Direct Organization Transfer
• Decreases the quantity of an item in one

organization and increases it in another
organization, performing both the issue and the
receipt transactions

• Decreases inventory values in the sending
organization and increases inventory values in the
receiving organization

• Always credits transfer and freight charges to the
shipping organization

• Does not make entries for direct inter-organization
transfers of expense items

• Does not go through intransit inventory
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Direct Inter-organization Transfers
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Direct Inter-organization TransfersDirect Inter-organization Transfers

Use the Inter-organization Transfer window to:
• Move material directly from the shipping

organization to the receiving organization
(N) INV Transactions > Inter-organization Transfer

Use the Inter-organization Transfer window to:
• Move material directly from the shipping

organization to the receiving organization
(N) INV Transactions > Inter-organization Transfer

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Inter-organization Transfers
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Review QuestionReview Question

Accounting flows for inter-organization transfers vary
depending on whether you transfer material directly
from one organization to another or transfer material
through intransit inventory.
1. True
2. False

Accounting flows for inter-organization transfers vary
depending on whether you transfer material directly
from one organization to another or transfer material
through intransit inventory.
1. True
2. False
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Review Question
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Review QuestionReview Question

Accounting flows for inter-organization transfers vary
depending on whether you transfer material directly
from one organization to another or transfer material
through intransit inventory.
1. True
2. False

Accounting flows for inter-organization transfers vary
depending on whether you transfer material directly
from one organization to another or transfer material
through intransit inventory.
1. True
2. False2. False
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Inter-organization Transfers Using Intransit FOB
Receipt
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Inter-organization Transfers
Using Intransit FOB Receipt
Inter-organization Transfers
Using Intransit FOB Receipt

Receive goodsReceive goods

IntransitIntransit

BostonBoston
ManufacturingManufacturing

Transfer goodsTransfer goods

Ship goodsShip goods

ChicagoChicago
ManufacturingManufacturing

FromFrom

FromFromToTo

ToTo

DirectDirect
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Inter-organization Transfers  Using Intransit FOB
Receipt
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Inter-organization Transfers
 Using Intransit FOB Receipt
Inter-organization Transfers
 Using Intransit FOB Receipt

FOB Receipt
• FOB Receipt means that the item belongs to the

shipping organization until the receiving
organization performs the Receipt transaction.
Intransit inventory belongs to the shipping
organization.

• Oracle Inventory decreases the quantity of the
item in the shipping organization but does not
increase it in the receiving organization until you
perform an intransit receipt transaction.

Intransit Inventory
• Intransit inventory represents material that has not

yet arrived at the receiving organization.

FOB Receipt
• FOB Receipt means that the item belongs to the

shipping organization until the receiving
organization performs the Receipt transaction.
Intransit inventory belongs to the shipping
organization.

• Oracle Inventory decreases the quantity of the
item in the shipping organization but does not
increase it in the receiving organization until you
perform an intransit receipt transaction.

Intransit Inventory
• Intransit inventory represents material that has not

yet arrived at the receiving organization.
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Inter-organization Transfers  Using Intransit FOB
Receipt
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Inter-organization Transfers
 Using Intransit FOB Receipt
Inter-organization Transfers
 Using Intransit FOB Receipt

Freight Charges: FOB Receipt
• If the FOB point is Receipt, the freight charges are

credited to the shipping organization.  Since title
has not passed, it is assumed that the shipping
organization pays the freight.

Inter-organization Transfer Charges
• Transfer charges can be added to the cost of the

shipment. The credit for transfer charges always
goes to the shipping organization.

Freight Charges: FOB Receipt
• If the FOB point is Receipt, the freight charges are

credited to the shipping organization.  Since title
has not passed, it is assumed that the shipping
organization pays the freight.

Inter-organization Transfer Charges
• Transfer charges can be added to the cost of the

shipment. The credit for transfer charges always
goes to the shipping organization.
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Inter-organization Transfers Using Intransit FOB
Receipt
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Inter-organization Transfers
Using Intransit FOB Receipt
Inter-organization Transfers
Using Intransit FOB Receipt

Use the Inter-organization Transfer window to:
• Move material from the shipping organization to

intransit inventory
(N) INV Transactions > Inter-organization Transfer
Use the Receipts window to:
• Move material from intransit inventory of the

receiving organization
(N) INV Transactions > Receiving > Receipts
Use the Manage Shipments window to:
• Update freight and arrival information for intransit

items
(N) INV Transactions > Receiving > Manage Shipments

Use the Inter-organization Transfer window to:
• Move material from the shipping organization to

intransit inventory
(N) INV Transactions > Inter-organization Transfer
Use the Receipts window to:
• Move material from intransit inventory of the

receiving organization
(N) INV Transactions > Receiving > Receipts
Use the Manage Shipments window to:
• Update freight and arrival information for intransit

items
(N) INV Transactions > Receiving > Manage Shipments

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Inter-organization Transfers
Help: Oracle Manufacturing Applications >Oracle Purchasing >
Receiving > Receiving Transactions
Help: Oracle Manufacturing Applications >Oracle Purchasing >
Receiving > Managing Receipts
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Review Question
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Review QuestionReview Question

FOB Receipt means that the item belongs to the
shipping organization until the receiving organization
performs the Receipt transaction. Intransit inventory
belongs to the shipping organization.
1. True
2. False

FOB Receipt means that the item belongs to the
shipping organization until the receiving organization
performs the Receipt transaction. Intransit inventory
belongs to the shipping organization.
1. True
2. False
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Review Question
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Review QuestionReview Question

FOB Receipt means that the item belongs to the
shipping organization until the receiving organization
performs the Receipt transaction. Intransit inventory
belongs to the shipping organization.
1. True
2. False

FOB Receipt means that the item belongs to the
shipping organization until the receiving organization
performs the Receipt transaction. Intransit inventory
belongs to the shipping organization.
1. True
2. False2. False
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Inter-organization Transfers Using Intransit FOB
Shipment
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Inter-organization Transfers
Using Intransit FOB Shipment
Inter-organization Transfers

Using Intransit FOB Shipment

Receive goodsReceive goods

IntransitIntransit

BostonBoston
ManufacturingManufacturing

Transfer goodsTransfer goods

Ship goodsShip goods

ChicagoChicago
ManufacturingManufacturing

FromFrom

FromFromToTo

ToTo

DirectDirect
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Inter-organization Transfers Using Intransit FOB
Shipment
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Inter-organization Transfers
Using Intransit FOB Shipment
Inter-organization Transfers

Using Intransit FOB Shipment

FOB Shipment
• FOB Shipment means that the item belongs to the

receiving organization as soon as the shipping
organization performs the Inter-organization
Transfer transaction.

• Intransit inventory belongs to the receiving
organization.

Freight Charges: FOB Shipment
• If the FOB point is Shipment, the freight charges

are credited to the receiving organization. Since
title has passed, it is assumed that the receiving
organization pays the freight.

FOB Shipment
• FOB Shipment means that the item belongs to the

receiving organization as soon as the shipping
organization performs the Inter-organization
Transfer transaction.

• Intransit inventory belongs to the receiving
organization.

Freight Charges: FOB Shipment
• If the FOB point is Shipment, the freight charges

are credited to the receiving organization. Since
title has passed, it is assumed that the receiving
organization pays the freight.
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Inter-organization Transfers Using Intransit FOB
Shipment
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Inter-organization Transfers
Using Intransit FOB Shipment
Inter-organization Transfers

Using Intransit FOB Shipment

Use the Inter-organization Transfer window to:
• Move material from the shipping organization to

intransit inventory of the receiving organization
(N) INV Transactions > Inter-organization Transfer

Use the Inter-organization Transfer window to:
• Move material from the shipping organization to

intransit inventory of the receiving organization
(N) INV Transactions > Inter-organization Transfer

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Inter-organization Transfers
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Inter-organization Transfers
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Inter-organization TransfersInter-organization Transfers

Use the Material Transaction Distributions window to
review accounting distributions of:
• Direct inter-organization transfers
• Intransit inter-organization transfers using FOB

shipment
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions

Use the Material Transaction Distributions window to
review accounting distributions of:
• Direct inter-organization transfers
• Intransit inter-organization transfers using FOB

shipment
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Viewing Material Transaction Distributions
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Review Question

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Review QuestionReview Question

FOB Shipment means that the item belongs to the
receiving organization as soon as the shipping
organization performs the Inter-organization Transfer
transaction. Intransit inventory belongs to the
receiving organization.
1. True
2. False

FOB Shipment means that the item belongs to the
receiving organization as soon as the shipping
organization performs the Inter-organization Transfer
transaction. Intransit inventory belongs to the
receiving organization.
1. True
2. False
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Review Question
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Review QuestionReview Question

FOB Shipment means that the item belongs to the
receiving organization as soon as the shipping
organization performs the Inter-organization Transfer
transaction. Intransit inventory belongs to the
receiving organization.
1. True
2. False

FOB Shipment means that the item belongs to the
receiving organization as soon as the shipping
organization performs the Inter-organization Transfer
transaction. Intransit inventory belongs to the
receiving organization.
1. True
2. False2. False
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Customer Shipments and Returns
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Customer Shipments and ReturnsCustomer Shipments and Returns

Customer Shipments
• You can use Oracle Order Management (OM) to

ship items on a sales order to a customer.
• When you record invoices in Accounts Receivable,

you need to run the inventory interface from OM
so that COGS is recorded. Invoicing in Accounts
Receivable is separate from COGS in Inventory.

(N) OM Returns > Returns > RMA Interface

Customer Shipments
• You can use Oracle Order Management (OM) to

ship items on a sales order to a customer.
• When you record invoices in Accounts Receivable,

you need to run the inventory interface from OM
so that COGS is recorded. Invoicing in Accounts
Receivable is separate from COGS in Inventory.

(N) OM Returns > Returns > RMA Interface

Help: Oracle Manufacturing Applications >
Oracle Order Management  > RMA Interface
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Customer Shipments and Returns
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Customer Shipments and ReturnsCustomer Shipments and Returns

Return Material Authorizations (RMA)
• When items are returned from a customer, you can

select to receive them into a subinventory or into
inspection.

• You can transfer expected receipt information to
Oracle Inventory by running the RMA interface.

(N) OM Returns > Returns > RMA Interface

Return Material Authorizations (RMA)
• When items are returned from a customer, you can

select to receive them into a subinventory or into
inspection.

• You can transfer expected receipt information to
Oracle Inventory by running the RMA interface.

(N) OM Returns > Returns > RMA Interface

Help: Oracle Manufacturing Applications >
Oracle Order Management  > RMA Interface
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Customer Shipments and Returns
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Customer Shipments and ReturnsCustomer Shipments and Returns

Use the RMA Receipts window to:
• Receive items back from a customer
(N) INV Transactions > Customer Returns > RMA Receipts

Use the Inspect window to:
• Inspect items back from a customer
• Receive or reject (return) items requiring

inspection
(N) INV Transactions > Customer Returns > RMA Inspect

Use the RMA Return window to:
• Return items back to a customer
(N) INV Transactions > Customer Returns > RMA Return

Use the RMA Receipts window to:
• Receive items back from a customer
(N) INV Transactions > Customer Returns > RMA Receipts

Use the Inspect window to:
• Inspect items back from a customer
• Receive or reject (return) items requiring

inspection
(N) INV Transactions > Customer Returns > RMA Inspect

Use the RMA Return window to:
• Return items back to a customer
(N) INV Transactions > Customer Returns > RMA Return

Help: Oracle Manufacturing Applications >Oracle Purchasing >
Receiving > Return
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Review QuestionReview Question

When items are returned from a customer, you can
select to receive them into a subinventory or into
inspection.
1. True
2. False

When items are returned from a customer, you can
select to receive them into a subinventory or into
inspection.
1. True
2. False
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Review Question
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Review QuestionReview Question

When items are returned from a customer, you can
select to receive them into a subinventory or into
inspection.
1. True
2. False

When items are returned from a customer, you can
select to receive them into a subinventory or into
inspection.
1. True
2. False2. False
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Inventory Adjustments
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Inventory AdjustmentsInventory Adjustments

• Cycle count and physical inventory transactions
are valued at standard cost.

• You can use cycle counting and physical
inventory to correct your inventory onhand
balances.

• Both the cycle count and physical inventory
update the accounts of the affected subinventory
and offset the adjustment account that you
specify.

• Cycle count and physical inventory transactions
are valued at standard cost.

• You can use cycle counting and physical
inventory to correct your inventory onhand
balances.

• Both the cycle count and physical inventory
update the accounts of the affected subinventory
and offset the adjustment account that you
specify.

AdjustmentsAdjustmentsInventoryInventory
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Inventory AdjustmentsInventory Adjustments

Use the Cycle Counts window to:
• To correct your inventory onhand balances
(N) INV Counting > Cycle Counting > Cycle Count Entries
Use the Physical Inventories window to:
• To correct your inventory onhand balances
(N) INV Counting > Physical Inventory > Physical Inventories

Use the Cycle Counts window to:
• To correct your inventory onhand balances
(N) INV Counting > Cycle Counting > Cycle Count Entries
Use the Physical Inventories window to:
• To correct your inventory onhand balances
(N) INV Counting > Physical Inventory > Physical Inventories

Help: Oracle Manufacturing Applications >Oracle Inventory >
Cycle Counting >Entering Cycle Counts
Help: Oracle Manufacturing Applications >Oracle Inventory >
Physical Inventory > Physical Inventory Counts
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Inventory Transactions
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Inventory TransactionsInventory Transactions

Use the Material Transaction Distributions window to:
• Review accounting distributions of inventory

adjustment transactions

(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions

Use the Material Transaction Distributions window to:
• Review accounting distributions of inventory

adjustment transactions

(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions

Help: Oracle Manufacturing Applications >Oracle Inventory >
Transactions >Viewing Material Transaction Distributions
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Review QuestionReview Question

You can use cycle counting and physical inventory to
correct your inventory onhand balances.
1. True
2. False

You can use cycle counting and physical inventory to
correct your inventory onhand balances.
1. True
2. False
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Review QuestionReview Question

You can use cycle counting and physical inventory to
correct your inventory onhand balances.
1. True
2. False

You can use cycle counting and physical inventory to
correct your inventory onhand balances.
1. True
2. False2. False
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Internal Sales OrdersInternal Sales Orders

Order entryOrder entry

ExpenseExpense

ShipShip
confirmconfirm

InventoryInventory
asset orasset or
expenseexpense InventoryInventory

asset orasset or
expenseexpense

ReceiveReceive

DirectDirect IntransitIntransitScheduleSchedule
orderorder

PickPick
releaserelease
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Internal RequisitionsInternal Requisitions

OracleOracle
InventoryInventory

OtherOther
systemssystems

OracleOracle
PlanningPlanning

DemandDemand

ManuallyManually
createcreate

••  Import orders in OM  Import orders in OM
/reschedule/reschedule
requisitionsrequisitions

Create internalCreate internal
sales ordersales order

RequestorRequestor

Source
?Order managementOrder management

PurchasePurchase
orderorder

VendorVendor

ScheduleSchedule
orderorder

OracleOracle
WIPWIP

••  Create internal  Create internal
sales order programsales order program
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Internal RequisitionsInternal Requisitions

Mechanism for Requesting and Issuing Material
• Internal requisitions provide the mechanism for

requesting and issuing material from internal
stores for delivery to other inventory or expense
destinations.

Mechanism for Requesting and Issuing Material
• Internal requisitions provide the mechanism for

requesting and issuing material from internal
stores for delivery to other inventory or expense
destinations.
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Internal RequisitionsInternal Requisitions

An internal requisition can go directly from pick
release to ship confirm as long as there is onhand
quantity.
After creating an internal requisition, you do the
following:
• Run the create internal sales order program in

purchasing
• Run the import orders program in Order

Management, entering the booked order in Order
Management

• Ship the internal sales order directly without
scheduling it

An internal requisition can go directly from pick
release to ship confirm as long as there is onhand
quantity.
After creating an internal requisition, you do the
following:
• Run the create internal sales order program in

purchasing
• Run the import orders program in Order

Management, entering the booked order in Order
Management

• Ship the internal sales order directly without
scheduling it
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Internal RequisitionsInternal Requisitions

• Internal requisitions do not have to go through
Order Management unless the require internal
sales order box is enabled in the shipping
networks window.

• If an internal sales order is not created, the
process continues like any other inter organization
transfer.

Use the Shipping Networks window to enable:
• The require internal sales order checkbox
(N) INV Setup > Organizations > Shipping Networks

• Internal requisitions do not have to go through
Order Management unless the require internal
sales order box is enabled in the shipping
networks window.

• If an internal sales order is not created, the
process continues like any other inter organization
transfer.

Use the Shipping Networks window to enable:
• The require internal sales order checkbox
(N) INV Setup > Organizations > Shipping Networks

Help: Oracle Manufacturing Applications >Oracle Inventory > Setting
Up > Transaction Setup >
Inter-Organization Shipping Network
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Internal RequisitionsInternal Requisitions

Destinations

Expense
subinventory

Asset
subinventory

Expense (to a
person)

Source Subinventory
Asset Item

Charge subinventory
expense account

Charge organization
valuation accounts

Designated requisition
charge account

Accounted for as:

Direct Interorg
transfer

Direct Interorg
transfer

Miscellaneous issue

All accounting done
in the issuing
organization

Direct Inter-organization Transfer
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Internal RequisitionsInternal Requisitions

Destinations

Expense
subinventory

Asset
subinventory

Expense (to a
person)

Source Subinventory
Asset Item

Charge subinventory
expense account

Charge organization
valuation accounts

Invalid

Accounted for as:

Intransit Interorg
transfer

Intransit Interorg
transfer

Not allowed

Intransit Inter-organization Transfer
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Review QuestionReview Question

Internal requisitions provide the mechanism for
requesting and issuing material from internal stores
for delivery to other inventory or expense
destinations.
1. True
2. False

Internal requisitions provide the mechanism for
requesting and issuing material from internal stores
for delivery to other inventory or expense
destinations.
1. True
2. False
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Review QuestionReview Question

Internal requisitions provide the mechanism for
requesting and issuing material from internal stores
for delivery to other inventory or expense
destinations.
1. True
2. False

Internal requisitions provide the mechanism for
requesting and issuing material from internal stores
for delivery to other inventory or expense
destinations.
1. True
2. False2. False
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SummarySummary

In this lesson, you should have learned how to:
• Set up standard costing
• Account for inventory transactions in standard

costing

In this lesson, you should have learned how to:
• Set up standard costing
• Account for inventory transactions in standard

costing

Ship goodsShip goodsReceive goodsReceive goodsPurchasesPurchases

IntransitIntransit AdjustmentsAdjustmentsDirectDirect
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Practice 1 OverviewPractice 1 Overview

This practice covers the following topics:
• Performing and analyzing inventory transactions
This practice covers the following topics:
•• Performing and analyzing inventory transactionsPerforming and analyzing inventory transactions
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Transactions

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Practice 1-1: Performing and Analyzing
Inventory Transactions

Practice 1-1: Performing and Analyzing
Inventory Transactions

In this practice, you are a buyer and do the following:
1.  Go to Seattle, M1. Check the status of the Material
Cost transaction processor. If this processor is not
running or is running at an interval greater than 10
minutes, inform the instructor.
2.  Check that the current period is open. If it is not
open, open it and all preceding unopened periods.
3. Based on your student number, select a purchased
item that is assigned to you. Create a purchase order
for your costed item for a quantity of 1000.
4.  Approve your purchase order and receive goods.
5.  View the accounting entries created by the receipts.

In this practice, you are a buyer and do the following:
1.  Go to Seattle, M1. Check the status of the Material
Cost transaction processor. If this processor is not
running or is running at an interval greater than 10
minutes, inform the instructor.
2.  Check that the current period is open. If it is not
open, open it and all preceding unopened periods.
3. Based on your student number, select a purchased
item that is assigned to you. Create a purchase order
for your costed item for a quantity of 1000.
4.  Approve your purchase order and receive goods.
5.  View the accounting entries created by the receipts.
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Practice 1-1: Performing and Analyzing Inventory
Transactions
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Practice 1-1: Performing and Analyzing
Inventory Transactions

Practice 1-1: Performing and Analyzing
Inventory Transactions

6.  Create an inventory of your purchased component.
What accounting entries are written by this
transaction?
7.  View the inventory history of your transactions.
What is the significance of the Costed column?
8.  View the accounting entries created by the
miscellaneous transactions.
Where did the debit and credit accounts come from?
9.  If time permits, run the Inventory Value Report for
your range of items. View the results online.
How could you set up the system to allow you to run
this report by product line?

6.  Create an inventory of your purchased component.
What accounting entries are written by this
transaction?
7.  View the inventory history of your transactions.
What is the significance of the Costed column?
8.  View the accounting entries created by the
miscellaneous transactions.
Where did the debit and credit accounts come from?
9.  If time permits, run the Inventory Value Report for
your range of items. View the results online.
How could you set up the system to allow you to run
this report by product line?
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Guided Practice 1-1: Checking the
Inferface Managers

Guided Practice 1-1: Checking the
Inferface Managers

1.  Navigate to the Interface Managers window in
Seattle, M1, to check the status of the Cost
Manager. If this manager is not running or is
running at an interval greater than 10 minutes,
inform the instructor.

(N) INV Setup > Transactions > Interface Managers

1.  Navigate to the Interface Managers window in
Seattle, M1, to check the status of the Cost
Manager. If this manager is not running or is
running at an interval greater than 10 minutes,
inform the instructor.

(N) INV Setup > Transactions > Interface Managers



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for Inventory Transactions for Standard Costing
Chapter 1 - Page 96

Guided Practice 1-1: Checking Current Period is Open

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Guided Practice 1-1: Checking Current
Period is Open

Guided Practice 1-1: Checking Current
Period is Open

1.  Navigate to the Inventory Accounting Periods
window to check that the current period is open. If
it is not open, open it and all preceding unopened
periods.

(N) INV Accounting Close Cycle > Inventory Accounting Periods

1.  Navigate to the Inventory Accounting Periods
window to check that the current period is open. If
it is not open, open it and all preceding unopened
periods.

(N) INV Accounting Close Cycle > Inventory Accounting Periods
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Guided Practice 1-1: Selecting Your
Purchased Item

Guided Practice 1-1: Selecting Your
Purchased Item

1. Your instructor will assign a student number to
you. Based on that number, select a purchased item
from the list below. You will use this costed purchase
item in the practices that follow.
Student   Student
Number  Purchased Item    Number Purchased Item
1   CM22680   7     CM82333
2   CM22682   8     CM88122
3   CM22683   9     CM08830
4   CM22684   10     RW44722
5   CM71557   11     RW66399
6   CM74123   12     RW77255

1. Your instructor will assign a student number to
you. Based on that number, select a purchased item
from the list below. You will use this costed purchase
item in the practices that follow.
Student   Student
Number  Purchased Item    Number Purchased Item
1   CM22680   7     CM82333
2   CM22682   8     CM88122
3   CM22683   9     CM08830
4   CM22684   10     RW44722
5   CM71557   11     RW66399
6   CM74123   12     RW77255
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Guided Practice 1-1: Creating Purchase
Orders

Guided Practice 1-1: Creating Purchase
Orders

1.  Navigate to the Purchase Orders window to create a
purchase order for your item in the M1 organization.
Set the receipt routing on the purchase order as direct
receipt.
(N) PURCHASING Purchase Orders > Purchase Orders (B) New
2.  Type: Standard Purchase Order
3.  Supplier: Advanced Network Devices
4.  Site: Santa Clara
5.  Ship to: M1
6.  Bill to: Accept default
7.  Buyer: Accept default
8.  Navigate to items.

1.  Navigate to the Purchase Orders window to create a
purchase order for your item in the M1 organization.
Set the receipt routing on the purchase order as direct
receipt.
(N) PURCHASING Purchase Orders > Purchase Orders (B) New
2.  Type: Standard Purchase Order
3.  Supplier: Advanced Network Devices
4.  Site: Santa Clara
5.  Ship to: M1
6.  Bill to: Accept default
7.  Buyer: Accept default
8.  Navigate to items.
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Guided Practice 1-1: Creating Purchase
Orders

Guided Practice 1-1: Creating Purchase
Orders

1.  Navigate to items (continued from previous page).
(N) PURCHASING Purchase Orders > Purchase Orders (B) New >
Items
2.  Number: 1
3.  Type: Goods
4.  Item: Your item
5.  Quantity: 1000
6.  Price: $50.00
     or you decide
7.  Promise date: Today
8.  Need by date: Today

1.  Navigate to items (continued from previous page).
(N) PURCHASING Purchase Orders > Purchase Orders (B) New >
Items
2.  Number: 1
3.  Type: Goods
4.  Item: Your item
5.  Quantity: 1000
6.  Price: $50.00
     or you decide
7.  Promise date: Today
8.  Need by date: Today

      9.  Choose: Shipments
10. Number: 1
11. Org: Your standard cost org
12. Ship to: M1, the location
      for your standard cost org
13. Quantity: Will default
14. Save your work.
15. Record your PO number
      here_________.

           (continued on next page)

      9.  Choose: Shipments
10. Number: 1
11. Org: Your standard cost org
12. Ship to: M1, the location
      for your standard cost org
13. Quantity: Will default
14. Save your work.
15. Record your PO number
      here_________.

           (continued on next page)
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Guided Practice 1-1: Approving Purchase
Orders

Guided Practice 1-1: Approving Purchase
Orders

1. Record your PO number here_________ (continued
from previous page).
2. Choose: Approve.
3. Submit for approval: X
You should see a message, “document submitted for
approval”.

1. Record your PO number here_________ (continued
from previous page).
2. Choose: Approve.
3. Submit for approval: X
You should see a message, “document submitted for
approval”.
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Guided Practice 1-1: Receiving GoodsGuided Practice 1-1: Receiving Goods

1. Navigate to the Receipts window to receive the
goods, once your purchase order has been approved.
(N) PURCHASING Receiving > Receipts

2.  Purchase Order: The one you noted earlier
3.  Choose: Find
4.  Enable the box next to the quantity field.
5.  Save your work.  If you are prompted for a
subinventory, enter the information and then save
your work.

1. Navigate to the Receipts window to receive the
goods, once your purchase order has been approved.
(N) PURCHASING Receiving > Receipts

2.  Purchase Order: The one you noted earlier
3.  Choose: Find
4.  Enable the box next to the quantity field.
5.  Save your work.  If you are prompted for a
subinventory, enter the information and then save
your work.
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Guided Practice 1-1: Viewing Accounting
Entries

Guided Practice 1-1: Viewing Accounting
Entries

1. Navigate to the Material Transaction Distributions
window, Accounts region, to review the accounting
distributions once you have received the goods.
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions
2.  Date: Accept the default of today’s date
3.  Item: Query your item

1. Navigate to the Material Transaction Distributions
window, Accounts region, to review the accounting
distributions once you have received the goods.
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions
2.  Date: Accept the default of today’s date
3.  Item: Query your item
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Guided Practice 1-1: Performing
Miscellaneous Receipts

Guided Practice 1-1: Performing
Miscellaneous Receipts

1.  Navigate to the Miscellaneous Transaction window
to create onhand quantities for your purchased items.
(N) INV Transactions > Miscellaneous Transaction
2.  Date: Accept the default of today’s date
3.  Type: Select account alias receipt
4.  Source: M1_STD_CST_ADJ
(N) INV Transactions > Miscellaneous Transaction

(B) Transaction Lines
5.  Item: Your item
6.  Subinventory: Stores
7.  Quantity: Enter a quantity greater than or equal to 20
8.  Action: Save
What accounting entries are written by this

transaction?
Debit inventory, credit an adjustment account

1.  Navigate to the Miscellaneous Transaction window
to create onhand quantities for your purchased items.
(N) INV Transactions > Miscellaneous Transaction
2.  Date: Accept the default of today’s date
3.  Type: Select account alias receipt
4.  Source: M1_STD_CST_ADJ
(N) INV Transactions > Miscellaneous Transaction

(B) Transaction Lines
5.  Item: Your item
6.  Subinventory: Stores
7.  Quantity: Enter a quantity greater than or equal to 20
8.  Action: Save
What accounting entries are written by this

transaction?
Debit inventory, credit an adjustment account
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Guided Practice 1-1: Viewing the
Inventory History

Guided Practice 1-1: Viewing the
Inventory History

1. Navigate to the Material Transaction window,
Transaction Type tab, to view the inventory history
of your transactions.
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (T) Transaction Type
2.  Date: Accept the default of today’s date
3.  Item: Query your item
What is the significance of the Costed column?
The Costed column indicated that the transaction has
been valued by the Material Cost processor; until it is
costed, you cannot view the accounting distributions.

1. Navigate to the Material Transaction window,
Transaction Type tab, to view the inventory history
of your transactions.
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (T) Transaction Type
2.  Date: Accept the default of today’s date
3.  Item: Query your item
What is the significance of the Costed column?
The Costed column indicated that the transaction has
been valued by the Material Cost processor; until it is
costed, you cannot view the accounting distributions.
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Guided Practice 1-1: Viewing Accounting
Entries

Guided Practice 1-1: Viewing Accounting
Entries

1. Navigate to the Material Transaction Distributions
window, Accounts region, to view the accounting
entries created by the miscellaneous transactions.
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions
2.  Date: Accept the default of today’s date
3.  Item: Query your item
Where did the debit and credit accounts come from?
The debit accounts came from the definition of the
subinventory into which you received the material.
The credit account came from the definition of the
Adjust account alias.

1. Navigate to the Material Transaction Distributions
window, Accounts region, to view the accounting
entries created by the miscellaneous transactions.
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions
2.  Date: Accept the default of today’s date
3.  Item: Query your item
Where did the debit and credit accounts come from?
The debit accounts came from the definition of the
subinventory into which you received the material.
The credit account came from the definition of the
Adjust account alias.
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Guided Practice 1-1: Running the
Inventory Value Report

Guided Practice 1-1: Running the
Inventory Value Report

1. Navigate to the Inventory Value Report Parameters
window to run the Inventory Value Report for your item
and enter parameters.
(N) CST Report > Value
2. Cost Type: Frozen
3. Sort Option: Item
4. Report Option: Detail
5. Item From: Your item
6. Item To: Your item
7. Category Set: Inv.Items
8. Select OK
9. Record your request number here_________.

1. Navigate to the Inventory Value Report Parameters
window to run the Inventory Value Report for your item
and enter parameters.
(N) CST Report > Value
2. Cost Type: Frozen
3. Sort Option: Item
4. Report Option: Detail
5. Item From: Your item
6. Item To: Your item
7. Category Set: Inv.Items
8. Select OK
9. Record your request number here_________.
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Guided Practice 1-1: Viewing the Results
Online

Guided Practice 1-1: Viewing the Results
Online

1. Navigate to the Requests window to check that
your report request has completed.
(N) CST Help > Requests (B) View Output

2. Query your request number.
3. View the results online.
How could you set up the system to allow you to run
this report by product line?
You could set up categories for each product line and
then run the report by category.

1. Navigate to the Requests window to check that
your report request has completed.
(N) CST Help > Requests (B) View Output

2. Query your request number.
3. View the results online.
How could you set up the system to allow you to run
this report by product line?
You could set up categories for each product line and
then run the report by category.
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Costing
Chapter 2
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Standard Costing
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 Standard Costing Standard Costing

Accounting for WIP Transactions
for Standard Costing

Accounting for WIP Transactions
for Standard Costing



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 3

Objectives

Copyright   Oracle Corporation, 2000. All rights reserved.
®

ObjectivesObjectives

After completing this lesson, you should be able
to do the following:
• Account for costs incurred in WIP
• Account for costs relieved from WIP
• Calculate this-level variances and previous-level

variances
• Describe how the standard cost update revalues

WIP

After completing this lesson, you should be able
to do the following:
• Account for costs incurred in WIP
• Account for costs relieved from WIP
• Calculate this-level variances and previous-level

variances
• Describe how the standard cost update revalues

WIP
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AgendaAgenda

• Overview of Standard Costing in WIP
• Accounting for costs incurred in WIP
• Accounting for costs relieved from WIP
• Calculate this-level variances and previous-level

variances
• Describe how the standard cost update revalues

WIP

• Overview of Standard Costing in WIP
•• Accounting for costs incurred in WIPAccounting for costs incurred in WIP
•• Accounting for costs relieved from WIPAccounting for costs relieved from WIP
•• Calculate this-level variances and previous-levelCalculate this-level variances and previous-level

variancesvariances
•• Describe how the standard cost update revaluesDescribe how the standard cost update revalues

WIPWIP
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OverviewOverview

Financial transactionsFinancial transactionsAudit trailAudit trail
QuantityQuantity

movementsmovements

If you use standard costing in manufacturing, Oracle
Cost Management:
• Values inventory on a transaction-based perpetual

basis
• Provides full visibility and control of production costs
• Tracks and reports costs through your various

stages of production as you transact

If you use standard costing in manufacturing, Oracle
Cost Management:
• Values inventory on a transaction-based perpetual

basis
• Provides full visibility and control of production costs
• Tracks and reports costs through your various

stages of production as you transact
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OverviewOverview

FinancialFinancial
transactionstransactionsAudit trailAudit trail

QuantityQuantity
movementsmovements

If you use standard costing in manufacturing, Oracle
Work in Process:
• Collects all costs
• Reports move, issue, resource, overhead,

completion, scrap, period close, and job close
transactions

If you use standard costing in manufacturing, Oracle
Work in Process:
• Collects all costs
• Reports move, issue, resource, overhead,

completion, scrap, period close, and job close
transactions



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 7

Overview

Copyright   Oracle Corporation, 2000. All rights reserved.
®

OverviewOverview

   ResourcesResources

OSPOSP

 $ $

AssembliesAssemblies

CostCost
IncurredIncurred
($)($)

CostCost
RelievedRelieved
($)($)

NetNet ValueValue ==
IncurredIncurred -- RelievedRelieved

OverheadOverhead

ComponentsComponents

 $ $

 $ $

 $ $

WIPWIP

 $ $

Cost always follows quantityCost always follows quantity
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Overview

Raw materialRaw material
subinventorysubinventory

Oracle Cost ManagementOracle Cost Management

Jobs and schedulesJobs and schedules
FinishedFinished

assembliesassemblies

• The transactions that are processed in Oracle
Inventory and in Oracle WIP are costed in Oracle
Cost Management

• The transactions that are processed in Oracle
Inventory and in Oracle WIP are costed in Oracle
Cost Management

FinishedFinished
GoodsGoods

subinventorysubinventory
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Describing the Relationship Between WIP
Transactions and Cost Management

Describing the Relationship Between WIPthe Relationship Between WIP
Transactions and Cost ManagementTransactions and Cost Management

Charging Material Transactions at Standard Cost
• You issue items from inventory to jobs and return

components from a job back to inventory at
standard cost.

Charging WIP Resource Transactions
• Charge resources at standard rates
• Charge resources at actual rates if the employee

and rate is setup in the direct labor tables for the
organization and the charge type for the resource
is manual

• Charges outside processing costs to a job at
standard cost if the standard rate box is checked ,
or at purchase order price if the standard rate box
is clear

Charging Material Transactions at Standard Cost
• You issue items from inventory to jobs and return

components from a job back to inventory at
standard cost.

Charging WIP Resource Transactions
• Charge resources at standard rates
• Charge resources at actual rates if the employee

and rate is setup in the direct labor tables for the
organization and the charge type for the resource
is manual

• Charges outside processing costs to a job at
standard cost if the standard rate box is checked ,
or at purchase order price if the standard rate box
is clear
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AgendaAgenda

• Overview of Average Costing in WIP
• Accounting for costs incurred in WIP
• Accounting for costs relieved from WIP
• Calculate this-level variances and previous-level

variances
• Describe how the standard cost update revalues

WIP

•• Overview of Average Costing in WIPOverview of Average Costing in WIP
• Accounting for costs incurred in WIP
•• Accounting for costs relieved from WIPAccounting for costs relieved from WIP
•• Calculate this-level variances and previous-levelCalculate this-level variances and previous-level

variancesvariances
•• Describe how the standard cost update revaluesDescribe how the standard cost update revalues

WIPWIP
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Accounting Flows: Costs Incurred,
Components Issued to WIP

Accounting Flows: Costs Incurred,
Components Issued to WIP

MaterialMaterial
transactionstransactions

WIPWIP

Components issued to WIPComponents issued to WIP
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Accounting Flows: Costs Incurred,
Components Issued to WIP

Components Issued to WIP Using Push or Pull
Transactions
Use push transactions to issue:
• All materials.
• Specific components.
Use pull (backflush) transactions to “pull” the
component material from inventory into WIP:
• Operation Pull pulls material from inventory when

the assembly completes the operation where the
components are consumed.

• Assembly Pull pulls material from inventory when
the assembly is completed from WIP into inventory.

Components Issued to WIP Using Push or Pull
Transactions
Use push transactions to issue:
• All materials.
• Specific components.
Use pull (backflush) transactions to “pull” the
component material from inventory into WIP:
• Operation Pull pulls material from inventory when

the assembly completes the operation where the
components are consumed.

• Assembly Pull pulls material from inventory when
the assembly is completed from WIP into inventory.
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Accounting Flows: Costs Incurred,
Components Issued to WIP

Viewing Charges Online
• Use the WIP Value Summary window to view

material charges to a specific job or schedule.
(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Viewing Charges Online
• Use the WIP Value Summary window to view

material charges to a specific job or schedule.
(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Components Issued to WIP

Accounting Flows: Costs Incurred,
Components Issued to WIP

Example
• You are a stockroom clerk for Vision. In your job,

you stage workorders, issuing push components
to jobs.  You also replace defective components
with substitute components.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following WIP material transactions:
– Issues of all push components
– Returns of specific components
– Issues of specific components

Example
• You are a stockroom clerk for Vision. In your job,

you stage workorders, issuing push components
to jobs.  You also replace defective components
with substitute components.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following WIP material transactions:
– Issues of all push components
– Returns of specific components
– Issues of specific components
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Accounting Flows: Costs Incurred,
Components Issued to WIP

Reviewing the WIP Value Summary (on the next page)
1.  WIP material transaction (issue all material)

Push all components into the job.
10 units at standard cost of $250 = $2,500.

2.  WIP material transaction (return specific component)
Return two defective units of component 2 to inventory.
2 units at standard cost of $33 = $66.

3.  WIP material transaction (issue specific component)
Replace defective components with substitute items.
2 units at standard cost of $40 = $80.

Reviewing the WIP Value Summary (on the next page)
1.  WIP material transaction (issue all material)

Push all components into the job.
10 units at standard cost of $250 = $2,500.

2.  WIP material transaction (return specific component)
Return two defective units of component 2 to inventory.
2 units at standard cost of $33 = $66.

3.  WIP material transaction (issue specific component)
Replace defective components with substitute items.
2 units at standard cost of $40 = $80.
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Components Issued to WIP

Accounting Flows: Costs Incurred,
Components Issued to WIP

The following table is a summary of all transactions
to this point.
The following table is a summary of all transactions
to this point.

Work in Process Value
Cost Incurred Cost Relieved Balance

Cost Element
This
Level

Previous
Level

This
Level

Previous
Level

This
Level

Previous
Level

Material 2,514 2,514
Material OH
Resource
OSP
Overhead
Total 2,514 2,514
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Review QuestionReview Question

When you use the supply type of “Operation Pull”,
the system pulls material from inventory when the
assembly completes the operation where the
components are consumed.
When you use the supply type of “Assembly Pull”,
the system pulls material from inventory when the
assembly is completed from WIP into inventory.
1. True
2. False

When you use the supply type of “Operation Pull”,
the system pulls material from inventory when the
assembly completes the operation where the
components are consumed.
When you use the supply type of “Assembly Pull”,
the system pulls material from inventory when the
assembly is completed from WIP into inventory.
1. True
2. False
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Review QuestionReview Question

When you use the supply type of “Operation Pull”,
the system pulls material from inventory when the
assembly completes the operation where the
components are consumed.
When you use the supply type of “Assembly Pull”,
the system pulls material from inventory when the
assembly is completed from WIP into inventory.
1. True
2. False

When you use the supply type of “Operation Pull”,
the system pulls material from inventory when the
assembly completes the operation where the
components are consumed.
When you use the supply type of “Assembly Pull”,
the system pulls material from inventory when the
assembly is completed from WIP into inventory.
1. True
2. False2. False
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Material Overhead

Accounting Flows: Costs Incurred,
Material OverheadMaterial Overhead

Material overhead charges to WIPMaterial overhead charges to WIP

MOH costsMOH costs

WIPWIP



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 20

Accounting Flows: Costs Incurred, Material Overhead

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Accounting Flows: Costs Incurred,
Material Overhead

Accounting Flows: Costs Incurred,
Material OverheadMaterial Overhead

Material Overhead Application
• Define material overheads under standard costing.
• Define as many material overhead subelements as

you want and base your charging in a variety of
ways: by item, activity, lot, or transaction value.

• Define default material overheads to apply to
selected categories of items or to all items in your
organization.

Material Overhead Application
• Define material overheads under standard costing.
• Define as many material overhead subelements as

you want and base your charging in a variety of
ways: by item, activity, lot, or transaction value.

• Define default material overheads to apply to
selected categories of items or to all items in your
organization.
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Accounting Flows: Costs Incurred,
Resource Charges to WIP

Accounting Flows: Costs Incurred,
Resource Charges to WIP

Resource charges to WIPResource charges to WIP

ResourceResource
transactionstransactions

WIPWIP
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Resource Charges to WIP

Accounting Flows: Costs Incurred,
Resource Charges to WIP

Resource Transactions
• Charge resources to WIP at actual cost or at the

standard resource amount in a standard costing
organization.

• Charge resources based on the charge type of the
resource, manual or WIP move.
– If the charge type is WIP move, the standard

resource amount is charged regardless of
whether you have an actual rate.

– If the charge type is manual, the system
checks to see if the the standard rate box is
enabled.  If it is, the system charges the
standard rate.

Resource Transactions
• Charge resources to WIP at actual cost or at the

standard resource amount in a standard costing
organization.

• Charge resources based on the charge type of the
resource, manual or WIP move.
– If the charge type is WIP move, the standard

resource amount is charged regardless of
whether you have an actual rate.

– If the charge type is manual, the system
checks to see if the the standard rate box is
enabled.  If it is, the system charges the
standard rate.
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Accounting Flows: Costs Incurred,
Resource Charges to WIP

Actual Versus Standard
• Charge resources at actual resource cost or at

standard resource cost, as controlled by the
Standard Rate value of each resource.

• When you charge resources at actual any
difference to the standard is recognized as a
variance when the job or schedule is closed.

• When you charge resources at standard, and use
actual labor rates, any difference is recognized as
a rate variance at the time of transaction.

Actual Versus Standard
• Charge resources at actual resource cost or at

standard resource cost, as controlled by the
Standard Rate value of each resource.

• When you charge resources at actual any
difference to the standard is recognized as a
variance when the job or schedule is closed.

• When you charge resources at standard, and use
actual labor rates, any difference is recognized as
a rate variance at the time of transaction.
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Resource Charges to WIP

Accounting Flows: Costs Incurred,
Resource Charges to WIP

Use the Move Transactions window to:
• Manually charge resources
• Automatically charges resources during move

transactions
(N) WIP Move Transactions > Move Transactions

Use the Move Transactions window to:
• Manually charge resources
• Automatically charges resources during move

transactions
(N) WIP Move Transactions > Move Transactions

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Shop Floor Control > Move Transactions >
Performing Move Transactions
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Accounting Flows: Costs Incurred,
Resource Charges to WIP

Accounting Flows: Costs Incurred,
Resource Charges to WIP

Viewing Charges Online
• Use the WIP Value Summary window to view

resource charges to a specific job or schedule.
(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Viewing Charges Online
• Use the WIP Value Summary window to view

resource charges to a specific job or schedule.
(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Accounting Flows: Costs Incurred,
Resource Charges to WIP

Accounting Flows: Costs Incurred,
Resource Charges to WIP

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you build
assemblies on workorders, charging resources to
jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor resource transactions:
– Resource transaction without rate variance
– Resource transaction reversal
– Resource transaction with rate variance

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you build
assemblies on workorders, charging resources to
jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor resource transactions:
– Resource transaction without rate variance
– Resource transaction reversal
– Resource transaction with rate variance
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Accounting Flows: Costs Incurred,
Resource Charges to WIP

Recording T Accounts for Transactions (on the next
page)

4.  Shop floor transaction (resource without rate variance)
     Charge resource RS1 at actual for operation 10.
     11 hours at $50 = $550.
5.  Shop floor transaction (reverse resource charge)

Reverse overcharge.
1 hour at $50 = $50.

6.  Shop floor transaction (resource with rate variance)
Charge resource RS2 at standard for operation 20.
5 units at $25 = $125.

Recording T Accounts for Transactions (on the next
page)

4.  Shop floor transaction (resource without rate variance)
     Charge resource RS1 at actual for operation 10.
     11 hours at $50 = $550.
5.  Shop floor transaction (reverse resource charge)

Reverse overcharge.
1 hour at $50 = $50.

6.  Shop floor transaction (resource with rate variance)
Charge resource RS2 at standard for operation 20.
5 units at $25 = $125.
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Accounting Flows: Costs Incurred,
Resource Charges to WIP

Accounting Flows: Costs Incurred,
Resource Charges to WIP

The following table is a summary of all transactions
to this point.
The following table is a summary of all transactions
to this point.

Work in Process Value
Cost Incurred Cost Relieved Balance

Cost Element
This
Level

Previous
Level

This
Level

Previous
Level

This
Level

Previous
Level

Material 2,514 2,514
Material OH
Resource 625 625
OSP
Overhead
Total    625 2,514    625 2,514
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Review QuestionReview Question

When you charge resources at actual any difference
to the standard is recognized as a variance when the
job or schedule is closed.
1. True
2. False

When you charge resources at actual any difference
to the standard is recognized as a variance when the
job or schedule is closed.
1. True
2. False
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Review QuestionReview Question

When you charge resources at actual any difference
to the standard is recognized as a variance when the
job or schedule is closed.
1. True
2. False

When you charge resources at actual any difference
to the standard is recognized as a variance when the
job or schedule is closed.
1. True
2. False2. False



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 31

Accounting Flows: Costs Incurred, Overhead Charges
to WIP

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Accounting Flows: Costs Incurred,
Overhead Charges to WIP

Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Overhead charges to WIPOverhead charges to WIP

OverheadOverhead
costscosts MOH costsMOH costs

WIPWIP
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Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Overhead Charges to WIP
• Define overheads under standard costing
• Define as many overhead subelements as you

want and base your charging in a variety of ways:
by item or lot, or based on resource units or value.

Overhead Charges to WIP
• Define overheads under standard costing
• Define as many overhead subelements as you

want and base your charging in a variety of ways:
by item or lot, or based on resource units or value.
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Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Overhead Charges to WIP
• Charge overhead costs automatically based on the

following:
– A percentage of resource or outside

processing value charged
– Resource units charged
– A fixed amount per item or lot

Overhead Charges to WIP
• Charge overhead costs automatically based on the

following:
– A percentage of resource or outside

processing value charged
– Resource units charged
– A fixed amount per item or lot
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Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Variable Overhead Charging
• Charge overhead as a percent of the resource

value earned in WIP.
• When using the Standard Rate value for the

resource, the overhead rate is multiplied by the
standard transaction value.

• When not using the Standard Rate value for the
resource (charge resource at actual), the overhead
rate is multiplied by the actual transaction value.

Variable Overhead Charging
• Charge overhead as a percent of the resource

value earned in WIP.
• When using the Standard Rate value for the

resource, the overhead rate is multiplied by the
standard transaction value.

• When not using the Standard Rate value for the
resource (charge resource at actual), the overhead
rate is multiplied by the actual transaction value.
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Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Example: Resource-Based Overhead
• Charge overhead for a setup activity.
• To charge a fixed amount for each hour of a setup

activity performed, you assign a setup overhead
based on resource units to the resource that
performs the setup activity.

• Whenever you charge the setup activity, the
overhead is charged as well.

Example: Resource-Based Overhead
• Charge overhead for a setup activity.
• To charge a fixed amount for each hour of a setup

activity performed, you assign a setup overhead
based on resource units to the resource that
performs the setup activity.

• Whenever you charge the setup activity, the
overhead is charged as well.
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Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Fixed Overhead Charging
• Charge overhead as a fixed amount per item or lot

moved through an operation or as a fixed amount
per resource unit earned at the operation.

Example: Move-Based Overhead
• Charge overhead for a move operation.
• To charge a fixed amount each time an item is

moved from an operation, you assign an overhead
based on item to the department that performs the
operation.

• Whenever you move the item out of the operation,
the overhead is charged.

Fixed Overhead Charging
• Charge overhead as a fixed amount per item or lot

moved through an operation or as a fixed amount
per resource unit earned at the operation.

Example: Move-Based Overhead
• Charge overhead for a move operation.
• To charge a fixed amount each time an item is

moved from an operation, you assign an overhead
based on item to the department that performs the
operation.

• Whenever you move the item out of the operation,
the overhead is charged.
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Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Viewing Charges Online
• Use the WIP Value Summary window to view

overhead charges to a specific job or schedule.
(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Viewing Charges Online
• Use the WIP Value Summary window to view

overhead charges to a specific job or schedule.
(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you move
assemblies on workorders. When you move
assemblies, the system charges overhead costs
automatically based on resource units or value or
by item or lot.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor overhead transactions:
– Resource-based overhead transaction
– Resource-based overhead transaction reversal
– Item-based overhead transaction

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you move
assemblies on workorders. When you move
assemblies, the system charges overhead costs
automatically based on resource units or value or
by item or lot.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor overhead transactions:
– Resource-based overhead transaction
– Resource-based overhead transaction reversal
– Item-based overhead transaction
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Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Recording T Accounts for Transactions (on the next page)
7.   Shop floor transaction (resource-based overhead)

 Charge 250% on the resource charged in step 4.
 $550 * 250% = $1,375.

8.   Shop floor transaction (reverse resource-based
      overhead)

 Reverse overhead for resource reversed in step 5.
 $50 * 250% = $125.

9.   Shop floor transaction (item-based overhead)
 Move through operation 20; charge item-based

      overhead.
 10 units at $20 = $200.

Recording T Accounts for Transactions (on the next page)
7.   Shop floor transaction (resource-based overhead)

 Charge 250% on the resource charged in step 4.
 $550 * 250% = $1,375.

8.   Shop floor transaction (reverse resource-based
      overhead)

 Reverse overhead for resource reversed in step 5.
 $50 * 250% = $125.

9.   Shop floor transaction (item-based overhead)
 Move through operation 20; charge item-based

      overhead.
 10 units at $20 = $200.
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Overhead Charges to WIP

Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

The following table is a summary of all transactions
to this point.
The following table is a summary of all transactions
to this point.

Work in Process Value
Cost Incurred Cost Relieved Balance

Cost Element
This
Level

Previous
Level

This
Level

Previous
Level

This
Level

Previous
Level

Material 2,514 2,514
Material OH
Resource 625 625
OSP
Overhead 1,450 1,450
Total  2075 2,514  2075 2,514
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Review QuestionReview Question

The system charges overhead costs automatically
based on a percentage of resource or outside
processing value charged, or based on resource
units charged, or based on a fixed amount per item or
lot.
1. True
2. False

The system charges overhead costs automatically
based on a percentage of resource or outside
processing value charged, or based on resource
units charged, or based on a fixed amount per item or
lot.
1. True
2. False
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Review QuestionReview Question

The system charges overhead costs automatically
based on a percentage of resource or outside
processing value charged, or based on resource
units charged, or based on a fixed amount per item or
lot.
1. True
2. False

The system charges overhead costs automatically
based on a percentage of resource or outside
processing value charged, or based on resource
units charged, or based on a fixed amount per item or
lot.
1. True
2. False2. False
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Accounting Flows: Costs Incurred,
Outside Processing

Outside processingOutside processing
 costs costs VariancesVariances

Outside Processing
• Charge outside processing costs to WIP at actual

or at standard as controlled by the Standard Rate
value of each outside processing resource.

Outside Processing
• Charge outside processing costs to WIP at actual

or at standard as controlled by the Standard Rate
value of each outside processing resource.
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Accounting Flows: Costs Incurred,
Outside Processing

Actual Versus Standard
• When you charge outside processing resources at

actual, you charge the purchase order cost to WIP
and recognize any difference between actual and
standard as a variance when you close the job or
schedule.

• When you charge outside processing resources at
standard, you recognize any difference to the
purchase order cost as a rate variance at the time
of transaction.

Actual Versus Standard
• When you charge outside processing resources at

actual, you charge the purchase order cost to WIP
and recognize any difference between actual and
standard as a variance when you close the job or
schedule.

• When you charge outside processing resources at
standard, you recognize any difference to the
purchase order cost as a rate variance at the time
of transaction.
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Accounting Flows: Costs Incurred,
Outside Processing

Outside Processing
• If you clear the Standard Rate check box, outside

processing is charged to WIP at the purchase
order unit cost.

• Associate an outside processing item to an
outside processing resource. When you move
assemblies into the Queue step of the routing
operation that calls for the related outside
processing resource, a purchase requisition for
this item is automatically created.

Outside Processing
• If you clear the Standard Rate check box, outside

processing is charged to WIP at the purchase
order unit cost.

• Associate an outside processing item to an
outside processing resource. When you move
assemblies into the Queue step of the routing
operation that calls for the related outside
processing resource, a purchase requisition for
this item is automatically created.
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Accounting Flows: Costs Incurred,
Outside Processing

Viewing Charges Online
• Use the WIP Value Summary window to view

outside processing (OSP) resource charges to a
specific job or schedule.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Viewing Charges Online
• Use the WIP Value Summary window to view

outside processing (OSP) resource charges to a
specific job or schedule.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Help: Oracle Manufacturing Applications  >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Accounting Flows: Costs Incurred,
Outside Processing

Example
• You are a shop floor production worker for Vision.

In your job, you receive assemblies on workorders
from outside suppliers and subcontractors,
charging outside processing resources to jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor outside processing (OSP)
resource transactions:
– OSP resource transaction without rate variance
– OSP resource transaction reversal
– Resource overhead on OSP resource

Example
• You are a shop floor production worker for Vision.

In your job, you receive assemblies on workorders
from outside suppliers and subcontractors,
charging outside processing resources to jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor outside processing (OSP)
resource transactions:
– OSP resource transaction without rate variance
– OSP resource transaction reversal
– Resource overhead on OSP resource
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Accounting Flows: Costs Incurred,
Outside Processing

Recording T Accounts for Transactions (on the next page)
10. Shop floor transaction

(OSP resource without rate variance)
Charge OSP OS1 at actual for operation 30.
Receive 11 units at $25 = $275.

11. Shop floor transaction
(reverse OSP charge)
Reverse overcharge.
1 unit at $25 = $25.

12. Shop floor transaction
(resource overhead on OSP resource)
Charge overhead at 1 unit at $20.

Recording T Accounts for Transactions (on the next page)
10. Shop floor transaction

(OSP resource without rate variance)
Charge OSP OS1 at actual for operation 30.
Receive 11 units at $25 = $275.

11. Shop floor transaction
(reverse OSP charge)
Reverse overcharge.
1 unit at $25 = $25.

12. Shop floor transaction
(resource overhead on OSP resource)
Charge overhead at 1 unit at $20.
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Outside Processing

The following table is a summary of all transactions
to this point.
The following table is a summary of all transactions
to this point.

Work in Process Value
Cost Incurred Cost Relieved Balance

Cost Element
This
Level

Previous
Level

This
Level

Previous
Level

This
Level

Previous
Level

Material 2,514 2,514
Material OH
Resource 625 625
OSP 250 250
Overhead 1,470 1,470
Total 2,345 2,514 2,345 2,514
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Review QuestionReview Question

When you charge outside processing resources at
standard, you recognize any difference to the
purchase order cost as a rate variance at the time
of transaction.
1. True
2. False

When you charge outside processing resources at
standard, you recognize any difference to the
purchase order cost as a rate variance at the time
of transaction.
1. True
2. False
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Review QuestionReview Question

When you charge outside processing resources at
standard, you recognize any difference to the
purchase order cost as a rate variance at the time
of transaction.
1. True
2. False

When you charge outside processing resources at
standard, you recognize any difference to the
purchase order cost as a rate variance at the time
of transaction.
1. True
2. False2. False
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Accounting Flows: Costs Incurred,
Viewing the WIP Value Summary

Use the WIP Value Summary window for a specific job
to view:
• Material charges
• Material overhead charges
• Resource charges
• Outside processing charges
• Overhead charges
(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Use the WIP Value Summary window for a specific job
to view:
• Material charges
• Material overhead charges
• Resource charges
• Outside processing charges
• Overhead charges
(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Help: Oracle Manufacturing Applications  >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Accounting Flows: Costs Incurred,
 Summary

Elemental Cost Distribution
• Distribute previous-level costs based on their

elemental cost structure and the valuation
accounts assigned to the accounting class.

• Distribute this-level costs based on the cost
element being charged and the valuation accounts
assigned to the accounting class.

• Material costs are always previous-level costs.

Elemental Cost Distribution
• Distribute previous-level costs based on their

elemental cost structure and the valuation
accounts assigned to the accounting class.

• Distribute this-level costs based on the cost
element being charged and the valuation accounts
assigned to the accounting class.

• Material costs are always previous-level costs.
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Review QuestionReview Question

You use the WIP Value Summary window to view
material, material overhead, resource, outside
processing and overhead charges to a specific job or
schedule.
1. True
2. False

You use the WIP Value Summary window to view
material, material overhead, resource, outside
processing and overhead charges to a specific job or
schedule.
1. True
2. False
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Review QuestionReview Question

You use the WIP Value Summary window to view
material, material overhead, resource, outside
processing and overhead charges to a specific job or
schedule.
1. True
2. False

You use the WIP Value Summary window to view
material, material overhead, resource, outside
processing and overhead charges to a specific job or
schedule.
1. True
2. False2. False
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AgendaAgenda

• Overview of Average Costing in WIP
• Accounting for costs incurred in WIP
• Accounting for costs relieved from WIP
• Calculate this-level variances and previous-level

variances
• Describe how the standard cost update revalues

WIP

•• Overview of Average Costing in WIPOverview of Average Costing in WIP
•• Accounting for costs incurred in WIPAccounting for costs incurred in WIP
• Accounting for costs relieved from WIP
•• Calculate this-level variances and previous-levelCalculate this-level variances and previous-level

variancesvariances
•• Describe how the standard cost update revaluesDescribe how the standard cost update revalues

WIPWIP
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Accounting Flows: Costs RelievedAccounting Flows: Costs Relieved

Assembly completion transactionsAssembly completion transactions

FinishedFinished
assemblyassembly

WIPWIP
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Accounting Flows: Costs Relieved,
Completion Transactions

Assembly Completion from WIP
• The system always relieves costs from WIP jobs

and schedules at the standard cost of the
assembly at the point of completion.

• You value completion transactions based on the
standard cost of the assembly being produced.

Valuation of Completion Transactions
• Completion transactions relieve the valuation

accounts of the WIP accounting class and charge
the subinventory accounts based on the elemental
cost structure of the assembly.

Assembly Completion from WIP
• The system always relieves costs from WIP jobs

and schedules at the standard cost of the
assembly at the point of completion.

• You value completion transactions based on the
standard cost of the assembly being produced.

Valuation of Completion Transactions
• Completion transactions relieve the valuation

accounts of the WIP accounting class and charge
the subinventory accounts based on the elemental
cost structure of the assembly.
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Performing Completion Transactions
Accounting Flows: Costs Relieved,

Performing Completion Transactions

Use the Completion Transactions window to:
• Complete assemblies
Use the Completion Transactions window to:
• Complete assemblies

(N) WIP Material Transaction > Completion Transactions(N) WIP Material Transaction > Completion Transactions

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Material Control >
Completing and Returning Assemblies
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Accounting Flows: Costs Relieved,
Completion Transactions

Viewing Charges Online
• Use the WIP Value Summary window to view relief

charges from WIP completion transactions from a
specific job or schedule.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Viewing Charges Online
• Use the WIP Value Summary window to view relief

charges from WIP completion transactions from a
specific job or schedule.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Accounting Flows: Costs Relieved,
Overcompletion Transactions

Costing of WIP Overcompletions
• Oracle Cost Management costs overcompletions

in discrete jobs or in repetitive schedules.
• Oracle Cost Management costs overcompletions

at the standard cost of the finished assemblies at
the point of completion.

Costing of WIP Overcompletions
• Oracle Cost Management costs overcompletions

in discrete jobs or in repetitive schedules.
• Oracle Cost Management costs overcompletions

at the standard cost of the finished assemblies at
the point of completion.

Job costingJob costing Period-basedPeriod-based
costingcosting

Costing at standardCosting at standard
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Accounting Flows: Costs Relieved,
Overcompletion Transactions

WIP Overcompletions
• For discrete jobs or repetitive schedules with or

without routings, you can enter actual completion
quantities in the job or schedule even if the
quantity exceeds the job or schedule quantity.

• Charges and reliefs are based on the initial start
quantity plus overcompletions so that variances
are not a result of the overcompletions.

• You can complete more assemblies from one
operation step to another so that you can track
which operation produced the extra assemblies.

WIP Overcompletions
• For discrete jobs or repetitive schedules with or

without routings, you can enter actual completion
quantities in the job or schedule even if the
quantity exceeds the job or schedule quantity.

• Charges and reliefs are based on the initial start
quantity plus overcompletions so that variances
are not a result of the overcompletions.

• You can complete more assemblies from one
operation step to another so that you can track
which operation produced the extra assemblies.
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Accounting Flows: Costs Relieved,
Overcompletion Transactions

• You can do an easy completion with or without
overcompletions. If an easy completion is executed
and the amount is greater than the start quantity of
the job, the system looks at the tolerance at the job
level to see whether or not the transaction can be
processed.

When you do an easy completion, the following happens:
• Assemblies are moved through each of the operations

defined for the job or schedule.
• Backflushes are performed.
• Resources are charged only if they are WIP move or

unless you go to the resource window and manually
charge resources before you save your work.

• You can do an easy completion with or without
overcompletions. If an easy completion is executed
and the amount is greater than the start quantity of
the job, the system looks at the tolerance at the job
level to see whether or not the transaction can be
processed.

When you do an easy completion, the following happens:
• Assemblies are moved through each of the operations

defined for the job or schedule.
• Backflushes are performed.
• Resources are charged only if they are WIP move or

unless you go to the resource window and manually
charge resources before you save your work.
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Accounting Flows: Costs Relieved,
Performing Overcompletion Transactions

Use the Move Transactions window to:
• Overcomplete assemblies
• Perform easy completions

Use the Move Transactions window to:
• Overcomplete assemblies
• Perform easy completions

(N) WIP Move Transactions > Move Transactions(N) WIP Move Transactions > Move Transactions

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Shop Floor Control >
Move Transactions > Performing Move Transactions
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Accounting Flows: Costs Relieved,
Overcompletion Transactions

Setup Considerations
• You establish specific tolerance levels for

overcompletions in WIP, to prevent mistakes or
large quantities of completions.

• Oracle Cost Management automatically costs any
overcompletions that are performed in WIP,
without any additional setup requirements.

Use the Work in Process Parameters window to:
• Specify overcompletion tolerance levels for

overcompletions
(N) WIP Setup > Parameters (T) Other

Setup Considerations
• You establish specific tolerance levels for

overcompletions in WIP, to prevent mistakes or
large quantities of completions.

• Oracle Cost Management automatically costs any
overcompletions that are performed in WIP,
without any additional setup requirements.

Use the Work in Process Parameters window to:
• Specify overcompletion tolerance levels for

overcompletions
(N) WIP Setup > Parameters (T) Other

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Setting Up > Defining WIP Parameters
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Accounting Flows: Costs Relieved,
Work Order-less Completions

Work Order-less Completions
• Work order-less completions can be performed in

a standard costing environment. You can
complete assemblies without having to create a
job or schedule.

• Oracle Cost Management costs work order-less
completions at the standard cost of the finished
assemblies at the point of completion.

Work Order-less Completions
• Work order-less completions can be performed in

a standard costing environment. You can
complete assemblies without having to create a
job or schedule.

• Oracle Cost Management costs work order-less
completions at the standard cost of the finished
assemblies at the point of completion.
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Accounting Flows: Costs Incurred,
Work Order-less Completions

Using work order-less completions, the system does
all of the following in one step at completion:
• Backflushes pull and push components
• Charges WIP move resources and overhead based on

the routing
• Completes assemblies to a designated completion

subinventory/locator
– No move transactions are required since the work

order-less completion backflushes and charges
resources at completion versus at each operation.

• Substitutes components by adding, deleting, and
substituting components that are not normally
associated with the assembly you are building

Using work order-less completions, the system does
all of the following in one step at completion:
• Backflushes pull and push components
• Charges WIP move resources and overhead based on

the routing
• Completes assemblies to a designated completion

subinventory/locator
– No move transactions are required since the work

order-less completion backflushes and charges
resources at completion versus at each operation.

• Substitutes components by adding, deleting, and
substituting components that are not normally
associated with the assembly you are building



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 68

Accounting Flows: Costs Relieved

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Accounting Flows: Costs RelievedAccounting Flows: Costs Relieved

Scrap transactionsScrap transactions

WIPWIP

Product assemblyProduct assembly
scrapscrap
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Scrap Transactions
• The system values scrap transactions at the

standard cost of the assembly through the
operation where the scrap transaction is recorded.

• The scrap transaction assumes that all material
required through the scrapping operation has
been charged to the job or schedule and expenses
that value.

• Assembly pull components are automatically
charge to the job or schedule if they are at or
before the operation where the scrap occurred.

Scrap Transactions
• The system values scrap transactions at the

standard cost of the assembly through the
operation where the scrap transaction is recorded.

• The scrap transaction assumes that all material
required through the scrapping operation has
been charged to the job or schedule and expenses
that value.

• Assembly pull components are automatically
charge to the job or schedule if they are at or
before the operation where the scrap occurred.

Note
If you have components that have a WIP supply type of assembly pull that are
consumed at or before the scrapping operation, you need to manually push them
into the job or schedule.



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 70

Accounting Flows: Costs Relieved, Scrap

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Accounting Flows: Costs Relieved, ScrapAccounting Flows: Costs Relieved, Scrap

Valuation of Scrap Transactions
• You control the accounting for scrap transactions

based on how you set the Require Scrap Account
check box in WIP Parameters of the organization.

• If the require scrap account is enabled at the
organization level, a scrap account will be required
before the scrap transaction is processed.  This is
true for workorderless completions also.  The
following entry will occur:

     Debit Scrap Expense
      Credit WIP

Valuation of Scrap Transactions
• You control the accounting for scrap transactions

based on how you set the Require Scrap Account
check box in WIP Parameters of the organization.

• If the require scrap account is enabled at the
organization level, a scrap account will be required
before the scrap transaction is processed.  This is
true for workorderless completions also.  The
following entry will occur:

     Debit Scrap Expense
      Credit WIP
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Valuation of Scrap Transactions
• If the require scrap account is not enabled, then

the transaction is completed like any other move
transaction and any scrap will fall out as wip
variance by cost element when the job is closed.

• If the execution is a workorderless completion
then the variance will be recorded when the
valuation is done for the workorderless
completion.

Valuation of Scrap Transactions
• If the require scrap account is not enabled, then

the transaction is completed like any other move
transaction and any scrap will fall out as wip
variance by cost element when the job is closed.

• If the execution is a workorderless completion
then the variance will be recorded when the
valuation is done for the workorderless
completion.
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Accounting Flows: Costs Relieved,
Performing Scrap Transactions

Use the Move Transactions window to:
• Scrap assemblies
Use the Move Transactions window to:
• Scrap assemblies

(N) WIP Move Transactions > Move Transactions(N) WIP Move Transactions > Move Transactions

Help: Oracle Manufacturing Applications  >
Oracle Work in Process > Shop Floor Control >
Move Transactions > Performing Move Transactions
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Accounting Flows: Costs Relieved,
Costing of Flow Schedule Scrap

Costing at standardCosting at standard Flow scheduleFlow schedule
scrap costingscrap costing

WIPWIP

Assembly scrapAssembly scrap

Return from scrapReturn from scrap

XX

ScrapScrap

XX

YY YY
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Accounting Flows: Costs Relieved,
Costing of Flow Schedule Scrap

Costing of Assembly Scrap
• You can scrap an assembly at any operation.

When you scrap an assembly at an operation, the
system automatically issues components that are
required at that operation and all prior operations.

• You can return scrapped assemblies, thus
returning the issue components back to inventory.

Costing of Assembly Scrap
• You can scrap an assembly at any operation.

When you scrap an assembly at an operation, the
system automatically issues components that are
required at that operation and all prior operations.

• You can return scrapped assemblies, thus
returning the issue components back to inventory.
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Accounting Flows: Costs Relieved,
Costing of Flow Schedule Scrap

Assembly Scrap
• You can scrap an assembly (debit scrap, credit WIP)

and return scrapped assemblies (debit WIP, credit
scrap) to scheduled and unscheduled flow schedules
at any routing operation.

• Oracle Cost Management automatically backflushes
push, operation-pull, and assembly-pull components
associated with the scrap operation and prior
operations.

• You can return scrapped assemblies within WIP, which
returns the issue components back to inventory.

Assembly Scrap
• You can scrap an assembly (debit scrap, credit WIP)

and return scrapped assemblies (debit WIP, credit
scrap) to scheduled and unscheduled flow schedules
at any routing operation.

• Oracle Cost Management automatically backflushes
push, operation-pull, and assembly-pull components
associated with the scrap operation and prior
operations.

• You can return scrapped assemblies within WIP, which
returns the issue components back to inventory.
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Accounting Flows: Costs Relieved,
Costing of Flow Schedule Scrap

Oracle Flow Manufacturing
• You can scrap an assembly in a Flow

manufacturing environment. You can scrap an
assembly at any operation, which means that
production is started according to the routing of
the assembly and the assembly is scrapped at the
specified operation.

• You can scrap an assembly from WIP, issuing the
components of the assembly that are required on
and prior to the scrap operation. Move-based
overheads, WIP move resources (and associated
overheads) used by the assembly on and prior to
the scrap operation are charged.

Oracle Flow Manufacturing
• You can scrap an assembly in a Flow

manufacturing environment. You can scrap an
assembly at any operation, which means that
production is started according to the routing of
the assembly and the assembly is scrapped at the
specified operation.

• You can scrap an assembly from WIP, issuing the
components of the assembly that are required on
and prior to the scrap operation. Move-based
overheads, WIP move resources (and associated
overheads) used by the assembly on and prior to
the scrap operation are charged.
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Accounting Flows: Costs Relieved,
Costing of Flow Schedule Scrap

Oracle Flow Manufacturing
• You can transfer the cost of the scrapped

assembly to a scrap account.
• You can return scrapped assemblies, so that all

the components issued and the resources (and
overheads) charged are returned to inventory. If
you return from scrap within WIP, you relieve the
scrap account.

• You can perform scrap and return from scrap
transactions for both scheduled and unscheduled
flow schedules.

Oracle Flow Manufacturing
• You can transfer the cost of the scrapped

assembly to a scrap account.
• You can return scrapped assemblies, so that all

the components issued and the resources (and
overheads) charged are returned to inventory. If
you return from scrap within WIP, you relieve the
scrap account.

• You can perform scrap and return from scrap
transactions for both scheduled and unscheduled
flow schedules.
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Accounting Flows: Costs Relieved,
Costing of Flow Schedule Scrap

Oracle Flow Manufacturing
• You can substitute (add, delete, change)

components to the assembly within WIP in a Scrap
or Return from Scrap transaction.

• You can scrap an assembly at an operation that
doesn’t exist in its routing, including substituted
components when scrapping assemblies without a
routing.

Oracle Flow Manufacturing
• You can substitute (add, delete, change)

components to the assembly within WIP in a Scrap
or Return from Scrap transaction.

• You can scrap an assembly at an operation that
doesn’t exist in its routing, including substituted
components when scrapping assemblies without a
routing.
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Accounting Flows: Costs Relieved,
Performing Assembly Scrap Transactions

Use the Work–Orderless Completions window to:
• Perform a WIP scrap transaction or a WIP return-

from-scrap transaction, using transaction types.
• Choose the WIP Scrap Transaction type to perform a

WIP scrap transaction.
• Choose the WIP Return from scrap transaction type

to perform a WIP return from scrap transaction.

Use the Work–Orderless Completions window to:
• Perform a WIP scrap transaction or a WIP return-

from-scrap transaction, using transaction types.
• Choose the WIP Scrap Transaction type to perform a

WIP scrap transaction.
• Choose the WIP Return from scrap transaction type

to perform a WIP return from scrap transaction.

(N) FLOW Production > Work Order-less Completions(N) FLOW Production > Work Order-less Completions

Help: Oracle Manufacturing Applications  >
Oracle Work in Process > Flow Manufacturing >
Performing Work Order-less Completions
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Accounting Flows: Costs Relieved,
Assembly Completion and Scrap

Example
• You are an assembler and a tester on a

subassembly production line for Vision. In your job,
you scrap defective assemblies and complete good
assemblies on workorders.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor scrap transactions and WIP
completion transaction:
– Scrap transaction
– Scrap transaction reversal
– WIP completion transaction

Example
• You are an assembler and a tester on a

subassembly production line for Vision. In your job,
you scrap defective assemblies and complete good
assemblies on workorders.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor scrap transactions and WIP
completion transaction:
– Scrap transaction
– Scrap transaction reversal
– WIP completion transaction
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Assembly Completion and Scrap

Recording T Accounts for Transactions (on the next page)
13. Shop floor transaction

 Scrap two assemblies at operation 40.
 2 units at $467 = $934.

14. Shop floor transaction
 Return repaired unit from scrap.
 1 unit at $467.

15. WIP completion transaction
 Complete nine assemblies from WIP to inventory.
 9 units at $467 = $4203 + 9 units at $20 for material

      overhead.

Recording T Accounts for Transactions (on the next page)
13. Shop floor transaction

 Scrap two assemblies at operation 40.
 2 units at $467 = $934.

14. Shop floor transaction
 Return repaired unit from scrap.
 1 unit at $467.

15. WIP completion transaction
 Complete nine assemblies from WIP to inventory.
 9 units at $467 = $4203 + 9 units at $20 for material

      overhead.
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Assembly Completion and Scrap

The following table is a summary of all transactions
to this point.
The following table is a summary of all transactions
to this point.

Work in Process Value
Cost Incurred Cost Relieved Balance

Cost Element
This
Level

Previous
Level

This
Level

Previous
Level

This
Level

Previous
Level

Material 2,514      14
Material OH
Resource 625 500 125
OSP 250   50
Overhead 1,470    445
Total 2,345 2,514    620     14

2,500

 1025
200

 1725  2500
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Review QuestionReview Question

Completion transactions relieve the valuation
accounts of the WIP accounting class and charge the
subinventory accounts based on the elemental cost
structure of the assembly.
1. True
2. False

Completion transactions relieve the valuation
accounts of the WIP accounting class and charge the
subinventory accounts based on the elemental cost
structure of the assembly.
1. True
2. False
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accounts of the WIP accounting class and charge the
subinventory accounts based on the elemental cost
structure of the assembly.
1. True
2. False

Completion transactions relieve the valuation
accounts of the WIP accounting class and charge the
subinventory accounts based on the elemental cost
structure of the assembly.
1. True
2. False2. False
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• Overview of Average Costing in WIP
• Accounting for costs incurred in WIP
• Accounting for costs relieved from WIP
• Calculate this-level variances and previous-level

variances
• Describe how the standard cost update revalues

WIP

•• Overview of Average Costing in WIPOverview of Average Costing in WIP
•• Accounting for costs incurred in WIPAccounting for costs incurred in WIP
•• Accounting for costs relieved from WIPAccounting for costs relieved from WIP
• Calculate this-level variances and previous-level

variances
•• Describe how the standard cost update revaluesDescribe how the standard cost update revalues

WIPWIP
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Variances
• The system recognizes variances when you close

your jobs and schedules.
• You do not close schedules; you close periods

that then recognize variances and zero out (clear)
balances on the schedule.

Variances
• The system recognizes variances when you close

your jobs and schedules.
• You do not close schedules; you close periods

that then recognize variances and zero out (clear)
balances on the schedule.

Elemental varianceElemental variance
accountsaccounts

VariancesVariances
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Variances
• The system recognizes variances for this-level

costs and previous-level costs.
This-Level Variances
• This-level variances compare the incurred

resource, outside processing, and overhead costs
charged into WIP to the standard routing costs of
the assembly being built.

• This-level variances are charged to the appropriate
resource, outside processing, or overhead
variance accounts that you defined for the
accounting class.

Variances
• The system recognizes variances for this-level

costs and previous-level costs.
This-Level Variances
• This-level variances compare the incurred

resource, outside processing, and overhead costs
charged into WIP to the standard routing costs of
the assembly being built.

• This-level variances are charged to the appropriate
resource, outside processing, or overhead
variance accounts that you defined for the
accounting class.
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Previous-Level Variances
• Previous-level variances compare incurred

component costs charged into WIP to the standard
component cost of the assembly being built.

• For variance purposes, previous-level costs are
considered to be material costs.  Material
overhead variances are included in the previous-
level material variance.

• Previous-level variances are charged to the
material variance account that you defined for the
accounting class.

Previous-Level Variances
• Previous-level variances compare incurred

component costs charged into WIP to the standard
component cost of the assembly being built.

• For variance purposes, previous-level costs are
considered to be material costs.  Material
overhead variances are included in the previous-
level material variance.

• Previous-level variances are charged to the
material variance account that you defined for the
accounting class.
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Source of Variances
• Material quantity usage variances

– Material list changes
– Backordered items
– Variable material quality from different

suppliers
– Defective parts
– Breakage
– Incorrect standards

Source of Variances
• Material quantity usage variances

– Material list changes
– Backordered items
– Variable material quality from different

suppliers
– Defective parts
– Breakage
– Incorrect standards



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 90

Accounting Flows: Variances

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Accounting Flows: VariancesAccounting Flows: Variances

Source of Variances
• Resource variances

– Production labor inefficiencies
– Inadequate repair and maintenance of

machines
– Wage rate differences
– Incorrect standards
– Outside processing price differences

• Overhead variances
– Production volume differences
– Actual spending not equal to targeted spending

Source of Variances
• Resource variances

– Production labor inefficiencies
– Inadequate repair and maintenance of

machines
– Wage rate differences
– Incorrect standards
– Outside processing price differences

• Overhead variances
– Production volume differences
– Actual spending not equal to targeted spending
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Example
• You are a production line supervisor for Vision. In

your job, you close workorders that are complete
and analyze variances.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following job close transaction:
– Job close transaction

Example
• You are a production line supervisor for Vision. In

your job, you close workorders that are complete
and analyze variances.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following job close transaction:
– Job close transaction



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 92

Review Question

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Review QuestionReview Question

For variance purposes, previous-level costs are
considered to be material costs.  Material overhead
variances are included in the previous-level material
variance.
1. True
2. False

For variance purposes, previous-level costs are
considered to be material costs.  Material overhead
variances are included in the previous-level material
variance.
1. True
2. False
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Review QuestionReview Question

For variance purposes, previous-level costs are
considered to be material costs.  Material overhead
variances are included in the previous-level material
variance.
1. True
2. False

For variance purposes, previous-level costs are
considered to be material costs.  Material overhead
variances are included in the previous-level material
variance.
1. True
2. False2. False
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• Overview of Average Costing in WIP
• Accounting for costs incurred in WIP
• Accounting for costs relieved from WIP
• Calculate this-level variances and previous-level

variances
• Describe how the standard cost update revalues

WIP

•• Overview of Average Costing in WIPOverview of Average Costing in WIP
•• Accounting for costs incurred in WIPAccounting for costs incurred in WIP
•• Accounting for costs relieved from WIPAccounting for costs relieved from WIP
•• Calculate this-level variances and previous-levelCalculate this-level variances and previous-level

variancesvariances
• Describe how the standard cost update revalues

WIP
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Standard costStandard cost
updateupdate
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Standard Cost UpdateStandard Cost Update

Automatic Revaluation and Accounting
• The cost update revalues your discrete and asset

nonstandard jobs.
• Discrete and asset nonstandard jobs are

automatically revalued.
• Accounting transactions are created by job by

cost element valuation account.
• The cost update automatically generates the WIP

Standard Cost Adjustment Report.

Automatic Revaluation and Accounting
• The cost update revalues your discrete and asset

nonstandard jobs.
• Discrete and asset nonstandard jobs are

automatically revalued.
• Accounting transactions are created by job by

cost element valuation account.
• The cost update automatically generates the WIP

Standard Cost Adjustment Report.

Note
The system does not revalue repetitive schedules because they are
transactionally based, and they may have been costed on a periodic basis that
would require revaluing prior period transactions.
The system always costs expense jobs on a periodic basis, and revaluing them
would require revaluing prior period transactions.
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Example: Updating previous-level costs
In the example on the next page, observe the following:
• Material cost increases by $50.
• Material overhead rate remains at 10%, but the cost

increases by $5 because of the increase in material
cost.

• Resource cost decreases by $15.
• Overhead rate increases from 100% to 150% of

resource cost.
• Overhead cost remains at $45 because of the

decrease in resource costs.
• Quantity in job = 10.

Example: Updating previous-level costs
In the example on the next page, observe the following:
• Material cost increases by $50.
• Material overhead rate remains at 10%, but the cost

increases by $5 because of the increase in material
cost.

• Resource cost decreases by $15.
• Overhead rate increases from 100% to 150% of

resource cost.
• Overhead cost remains at $45 because of the

decrease in resource costs.
• Quantity in job = 10.
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Example: Updating previous-level costsExample: Updating previous-level costs

      
 Material MOH Resource OSP Overhead Total

Old cost 150 15 45 0 45 255

New cost 200 20 30 0 45 295

Increase/
(decrease)   50   5 (15) 0   0   40

      
 Material MOH Resource OSP Overhead Total

Old cost 150 15 45 0 45 255

New cost 200 20 30 0 45 295

Increase/
(decrease)   50   5 (15) 0   0   40

Bill of Material CostsBill of Material Costs



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 99

Standard Cost Update

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Standard Cost UpdateStandard Cost Update

Example: Updating this-level costs
In the example on the next page, observe the

following:
• Changes to This-Level Costs
• Resource RS1 amount decreases by $5.
• Outside processing OS1 amount per item increases

by $20.
• Overhead rate increases from 200% of RS1 value to

400% of RS1 value.
• 10 hours of RS1 are charged to the job.
• 10 units are received for OS1.

Example: Updating this-level costs
In the example on the next page, observe the

following:
• Changes to This-Level Costs
• Resource RS1 amount decreases by $5.
• Outside processing OS1 amount per item increases

by $20.
• Overhead rate increases from 200% of RS1 value to

400% of RS1 value.
• 10 hours of RS1 are charged to the job.
• 10 units are received for OS1.
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Example: Updating this-level costsExample: Updating this-level costs

Resource OSP Overhead Total

Old cost 35 100 70 205

New cost 30 120 120 270

Increase/(decrease) (5) 20 50 65

Resource OSP Overhead Total

Old cost 35 100 70 205

New cost 30 120 120 270

Increase/(decrease) (5) 20 50 65

Routing CostsRouting Costs
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Adjustment Recorded in the Job:  Job Value
Material

Overhead Resource
Outside

 Processing OverheadMaterial Total
This
level
Prev
level

Incr/Decr

500

500

50

50

(50)

(150)

(200)

200

200

0

500

0

500 650

400

1050

Example: Adjusting accounting entry
• This-level costs and previous-level costs are

adjusted in the job, but all adjustments to a job are
combined into one set of accounting entries.

Example: Adjusting accounting entry
• This-level costs and previous-level costs are

adjusted in the job, but all adjustments to a job are
combined into one set of accounting entries.
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Material
Overhead Resource

Outside
Processing Overhead

1050

Material

  Standard
Cost

  Variance
Acct

Adjusting Accounting Entry: WIP Accounts Accounting Class

500 200 50050 200

Example: Adjusting accounting entry
• This-level costs and previous-level costs are

adjusted in the job, but all adjustments to a job are
combined into one set of accounting entries.

Example: Adjusting accounting entry
• This-level costs and previous-level costs are

adjusted in the job, but all adjustments to a job are
combined into one set of accounting entries.
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Review QuestionReview Question

The cost update revalues your discrete and asset
nonstandard jobs automatically, creating accounting
transactions by job and by cost element valuation
account.
The cost update automatically generates the WIP
Standard Cost Adjustment Report.
1. True
2. False

The cost update revalues your discrete and asset
nonstandard jobs automatically, creating accounting
transactions by job and by cost element valuation
account.
The cost update automatically generates the WIP
Standard Cost Adjustment Report.
1. True
2. False
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Review QuestionReview Question

The cost update revalues your discrete and asset
nonstandard jobs automatically, creating accounting
transactions by job and by cost element valuation
account.
The cost update automatically generates the WIP
Standard Cost Adjustment Report.
1. True
2. False

The cost update revalues your discrete and asset
nonstandard jobs automatically, creating accounting
transactions by job and by cost element valuation
account.
The cost update automatically generates the WIP
Standard Cost Adjustment Report.
1. True
2. False2. False



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 105

Summary

Copyright   Oracle Corporation, 2000. All rights reserved.
®

SummarySummary

In this lesson, you should have learned how to:
• Account for costs incurred in WIP
• Account for costs relieved from WIP
• Calculate this-level variances and previous-level

variances
• Describe how the standard cost update revalues

WIP

In this lesson, you should have learned how to:
• Account for costs incurred in WIP
• Account for costs relieved from WIP
• Calculate this-level variances and previous-level

variances
• Describe how the standard cost update revalues

WIP
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This practice covers the following topics:
• Performing and analyzing WIP transactions in a

standard costing environment
• Reviewing a business scenario for WIP costing,

discussing the impact of overcompletions, scrap
and phantom costing

• Performing and analyzing WIP transactions in a
standard costing environment to observe the
behavior of phantoms, overcompletions, and
scrap

This practice covers the following topics:
• Performing and analyzing WIP transactions in a

standard costing environment
• Reviewing a business scenario for WIP costing,

discussing the impact of overcompletions, scrap
and phantom costing

• Performing and analyzing WIP transactions in a
standard costing environment to observe the
behavior of phantoms, overcompletions, and
scrap



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 107

Reviewing the Cost Structure for AS62445 in the Vision
Database

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Reviewing the Cost Structure for
AS62445 in the Vision Database

Reviewing the Cost Structure for
AS62445 in the Vision Database

Subassembly=SB22680Subassembly=SB22680

 Final assembly=AS62445 Final assembly=AS62445

Phantom assembly=PH22681Phantom assembly=PH22681

PurchasedPurchased
item=CM22680item=CM22680

PurchasedPurchased
item=CM22684item=CM22684

PurchasedPurchased
item=CM22682item=CM22682

PurchasedPurchased
item=CM22683item=CM22683
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Reviewing the Cost Structure for
AS62445 in the Vision Database

Reviewing the Cost Structure for
AS62445 in the Vision Database

Vision Database Data
• Data was populated in the Vision database to

facilitate practices and demonstrations. In this
course, we will demonstrate functionality using
AS62445, performing transactions and seeing their
financial impact.

• For standard costing, we use the M1 organization,
verifying that costs exist in the Frozen cost type.

Vision Database Data
• Data was populated in the Vision database to

facilitate practices and demonstrations. In this
course, we will demonstrate functionality using
AS62445, performing transactions and seeing their
financial impact.

• For standard costing, we use the M1 organization,
verifying that costs exist in the Frozen cost type.
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AS62445 in the Vision Database

Reviewing the Cost Structure for
AS62445 in the Vision Database

Assumptions
• Supply types for components:

CM22680, push; CM22682, operation pull;
CM22683, assembly pull; SB22680, operation pull.

• All resources except lead prep were person type
resources having the following: UOM=HR, charge
type = WIP move, basis = item and overhead =
benefits. The only difference with lead prep was
that it was a machine type resource.

• Existing departments were used for assembly,
test, pack, and upgrade.

Assumptions
• Supply types for components:

CM22680, push; CM22682, operation pull;
CM22683, assembly pull; SB22680, operation pull.

• All resources except lead prep were person type
resources having the following: UOM=HR, charge
type = WIP move, basis = item and overhead =
benefits. The only difference with lead prep was
that it was a machine type resource.

• Existing departments were used for assembly,
test, pack, and upgrade.
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Reviewing the Cost Structure for
AS62445 in the Vision Database

Reviewing the Cost Structure for
AS62445 in the Vision Database

Assumptions
• Routings were created with operation sequences

set to backflush, usage set at 10 units per hour,
and completion and supply subinventories from
RIP
– Existing overheads were used for material

handling, equipment/tool, preventative
maintenance, benefits, and manufacturing
management.

• Ensure that the interface managers are up and
running.

Assumptions
• Routings were created with operation sequences

set to backflush, usage set at 10 units per hour,
and completion and supply subinventories from
RIP
– Existing overheads were used for material

handling, equipment/tool, preventative
maintenance, benefits, and manufacturing
management.

• Ensure that the interface managers are up and
running.
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Practice 2-1: Performing and Analyzing
WIP Transactions in Standard Costing

Practice 2-1: Performing and Analyzing
WIP Transactions in Standard Costing

In this practice, you are a cost accountant and you
define and process a discrete job from release to
completion. After each WIP transaction that you
perform, you review the job value using the WIP
Value Summary window. This will help you to analyze
the impact of each transaction.

In this practice, you are a cost accountant and you
define and process a discrete job from release to
completion. After each WIP transaction that you
perform, you review the job value using the WIP
Value Summary window. This will help you to analyze
the impact of each transaction.

Instructions
1. Check the status of the Material Cost transaction processor. If this processor
is not running or is running at an interval greater than 10 minutes, inform the
instructor.
2. Define a released, discrete job for AS62445. Set the quantity equal to 10 and
the due date equal to Friday of this week.
Record the job number that the system assigns here:_______
3.  Issue to the job any push material needed at the start of the job and 5
addtional pieces of CM22680.
4. Move the job through its routing. Execute a scrap transaction for a quantity of
2 and verify that the assembly pull components are charged to the job.
5. Receive a partial quantity into the finished goods (FGI) subinventory.
6. Receive the balance of the job into the FGI subinventory.
7. Close the job. Be careful to close only your job, to avoid interfering with
other students’ jobs.
8. Review material transaction distributions and job costs in the Material
Transaction Distributions window and the WIP Value Summary window. View
the accounting distributions created by the transactions and item costs.
9. If time permits, run the Discrete Job Value Report for your job, and review
the results online. 
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Guided Practice 2-1: Checking the
Inferface Managers

Guided Practice 2-1: Checking the
Inferface Managers

1.  Navigate to the Interface Managers window to
check the status of the Cost Manager. If this
manager is not running or is running at an interval
greater than 10 minutes, inform the instructor.

(N) INV Setup > Transactions > Interface Managers

1.  Navigate to the Interface Managers window to
check the status of the Cost Manager. If this
manager is not running or is running at an interval
greater than 10 minutes, inform the instructor.

(N) INV Setup > Transactions > Interface Managers



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 113

Guided Practice 2-1: Defining Discrete Jobs

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Guided Practice 2-1: Defining Discrete
Jobs

Guided Practice 2-1: Defining Discrete
Jobs

1.  Navigate to the Discrete Jobs window to define a
released, discrete job for AS62445, as follows:

(N) WIP Discrete > Discrete Jobs (B) New
2.  Job: xx-job01, where xx are your initials
3.  Type: Standard
4.  Assembly: AS62445
5.  Class: Discrete
6.  Status: Released
7.  Start quantity: 10
8.  MRP Net 10
9.  Completion date: Friday of this week as DD-MON-YY
10.Save and record the job number that the system
assigns here:_______

1.  Navigate to the Discrete Jobs window to define a
released, discrete job for AS62445, as follows:

(N) WIP Discrete > Discrete Jobs (B) New
2.  Job: xx-job01, where xx are your initials
3.  Type: Standard
4.  Assembly: AS62445
5.  Class: Discrete
6.  Status: Released
7.  Start quantity: 10
8.  MRP Net 10
9.  Completion date: Friday of this week as DD-MON-YY
10.Save and record the job number that the system
assigns here:_______
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Guided Practice 2-1: Checking Material
Requirements

Guided Practice 2-1: Checking Material
Requirements

1.  Navigate to the Material Requirements window to
check your material requirements for any push
material needed at the start of the job.

(N) WIP Discrete > Discrete Jobs (F) Enter job number (B)
Components > Supply

1.  Navigate to the Material Requirements window to
check your material requirements for any push
material needed at the start of the job.

(N) WIP Discrete > Discrete Jobs (F) Enter job number (B)
Components > Supply
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Guided Practice 2-1: Issuing Push
Material

Guided Practice 2-1: Issuing Push
Material

1.  Navigate to the Material Transactions window to
issue your push material needed at the start of the
job.

(N) WIP Material Transactions > WIP Material Transactions
2.  Job: xx-job01, where xx are your initials
3.  Date: Today’s date
4.  Type: WIP component issue
5.  Subinventory: Stores
6.  Choose: Transact
7.  Action: Check that your push components appear
8.  Choose: Done

1.  Navigate to the Material Transactions window to
issue your push material needed at the start of the
job.

(N) WIP Material Transactions > WIP Material Transactions
2.  Job: xx-job01, where xx are your initials
3.  Date: Today’s date
4.  Type: WIP component issue
5.  Subinventory: Stores
6.  Choose: Transact
7.  Action: Check that your push components appear
8.  Choose: Done
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Material

Guided Practice 2-1: Valuing Push
Material

1.  Navigate to the Material Transaction Distributions
window to verify that your push material needed at
the start of the job was recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions
2.  Item: CM22680

1.  Navigate to the Material Transaction Distributions
window to verify that your push material needed at
the start of the job was recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions
2.  Item: CM22680
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Guided Practice 2-1: Valuing Your Job
using the WIP Value Summary

Guided Practice 2-1: Valuing Your Job
using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify that your push material needed at the start
of the job was recorded and valued.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components

and your job
4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your push

components and your job

1.  Navigate to the WIP Value Summary window to
verify that your push material needed at the start
of the job was recorded and valued.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components

and your job
4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your push

components and your job
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Material

Guided Practice 2-1: Issuing Push
Material

1.  Navigate to the Material Transactions window to
issue five additional pieces of CM22680 to the job.

(N) WIP Material Transactions > WIP Material Transactions
2.  Job: xx-job01
3.  Date: Today’s date
4.  Type: WIP component issue
5.  Subinventory: Stores
6.  Choose: Specific component
7.  Choose: Transact
8.  Item: CM22680
9.  Subinventory: Stores
10.Operation: 10
11.Choose: Done

1.  Navigate to the Material Transactions window to
issue five additional pieces of CM22680 to the job.

(N) WIP Material Transactions > WIP Material Transactions
2.  Job: xx-job01
3.  Date: Today’s date
4.  Type: WIP component issue
5.  Subinventory: Stores
6.  Choose: Specific component
7.  Choose: Transact
8.  Item: CM22680
9.  Subinventory: Stores
10.Operation: 10
11.Choose: Done
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Guided Practice 2-1: Valuing Push
Material

Guided Practice 2-1: Valuing Push
Material

1.  Navigate to the Material Transaction Distributions
window to verify that your additional five pieces of
CM22680 were recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions
2.  Item: CM22680

1.  Navigate to the Material Transaction Distributions
window to verify that your additional five pieces of
CM22680 were recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions
2.  Item: CM22680
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Guided Practice 2-1: Reviewing Job
Costs Using the WIP Value Summary
Guided Practice 2-1: Reviewing Job
Costs Using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify that your additional five pieces of CM22680
were recorded and valued.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components,

your additional components and your job
4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job.

1.  Navigate to the WIP Value Summary window to
verify that your additional five pieces of CM22680
were recorded and valued.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components,

your additional components and your job
4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job.
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Guided Practice 2-1: Performing Move
Transactions

Guided Practice 2-1: Performing Move
Transactions

1.  Move all of the assemblies From Op Seq: 10, Step:
Queue to Op Seq: 20, Step: To Move.

(N) WIP Move Transactions > Move Transactions
2.  Job: xx-job01
3.  From Op Seq: 10, Step Queue
4.  Complete: No
5. To: Seq 20, Step: To move
6.  Quantity: 10
7.  Date:Today’s date
8.  Choose: Resources
9.  Observe how employee information appears
10.Enter employee #
11.Quantity: 10
12.Save

1.  Move all of the assemblies From Op Seq: 10, Step:
Queue to Op Seq: 20, Step: To Move.

(N) WIP Move Transactions > Move Transactions
2.  Job: xx-job01
3.  From Op Seq: 10, Step Queue
4.  Complete: No
5. To: Seq 20, Step: To move
6.  Quantity: 10
7.  Date:Today’s date
8.  Choose: Resources
9.  Observe how employee information appears
10.Enter employee #
11.Quantity: 10
12.Save
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Guided Practice 2-1: Valuing Your Job
using the WIP Value Summary

Guided Practice 2-1: Valuing Your Job
using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components,

your additional components, and your moves in
your job

4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job.
7.  Choose Cost Element: Resource
8.  Choose: Distributions
9.  Action: Verify the distributions of your job.

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components,

your additional components, and your moves in
your job

4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job.
7.  Choose Cost Element: Resource
8.  Choose: Distributions
9.  Action: Verify the distributions of your job.



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for WIP Transactions for Standard Costing
Chapter 2 - Page 123

Guided Practice 2-1: Performing Easy Completions

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Guided Practice 2-1: Performing Easy
Completions

Guided Practice 2-1: Performing Easy
Completions

1.  Perform an easy completion for five of the
assemblies.

(N) WIP Move Transactions > Move Transactions
2.  Job: xx-job01
3.  Complete: Yes
4.  From Op Seq: 10, Step Queue
5. To: Seq 20, Step: To move
6.  Quantity: 5
7.  Date:Today’s date
8.  Choose: Transact

1.  Perform an easy completion for five of the
assemblies.

(N) WIP Move Transactions > Move Transactions
2.  Job: xx-job01
3.  Complete: Yes
4.  From Op Seq: 10, Step Queue
5. To: Seq 20, Step: To move
6.  Quantity: 5
7.  Date:Today’s date
8.  Choose: Transact
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Guided Practice 2-1: Valuing Easy
Completions

Guided Practice 2-1: Valuing Easy
Completions

1.  Navigate to the Material Transaction Distributions
window to verify that your five easy completions
were recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions >
Reason, Reference

2.  Item: AS62445
3.  Costed: Yes

1.  Navigate to the Material Transaction Distributions
window to verify that your five easy completions
were recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions >
Reason, Reference

2.  Item: AS62445
3.  Costed: Yes
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Guided Practice 2-1: Valuing Your Job
using the WIP Value Summary

Guided Practice 2-1: Valuing Your Job
using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components,

your additional components, your moves and your
completions in your job

4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job.
7.  Choose Cost Element: Resource
8.  Choose: Distributions
9.  Action: Verify the distributions of your job.

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components,

your additional components, your moves and your
completions in your job

4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job.
7.  Choose Cost Element: Resource
8.  Choose: Distributions
9.  Action: Verify the distributions of your job.
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Guided Practice 2-1: Verifying Item CostsGuided Practice 2-1: Verifying Item Costs

1.  Navigate to the Item Cost Details window to verify
the cost of your assembly under Cost Information.

(N) CST Item Costs > Item Costs

2.  Item: AS62445
3.  Choose: Find
4.  Choose: Open
5.  Action: Review Cost Information

1.  Navigate to the Item Cost Details window to verify
the cost of your assembly under Cost Information.

(N) CST Item Costs > Item Costs

2.  Item: AS62445
3.  Choose: Find
4.  Choose: Open
5.  Action: Review Cost Information
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Guided Practice 2-1: Performing Move
Transactions to Scrap

Guided Practice 2-1: Performing Move
Transactions to Scrap

1.  Move 2 of the assemblies from Op Seq: 20, Step:
To Move to Op Seq: 20, Step: Scrap

(N) WIP Move Transactions > Move Transactions
2.  Job: xx-job01
3.  From Op Seq: 20, Step: To move
4.  Complete: No
5. To: Seq 20, Step: Scrap
6.  Quantity: 2
7.  Choose: Transact

1.  Move 2 of the assemblies from Op Seq: 20, Step:
To Move to Op Seq: 20, Step: Scrap

(N) WIP Move Transactions > Move Transactions
2.  Job: xx-job01
3.  From Op Seq: 20, Step: To move
4.  Complete: No
5. To: Seq 20, Step: Scrap
6.  Quantity: 2
7.  Choose: Transact
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Guided Practice 2-1: Reviewing Job
Costs Using the WIP Value Summary
Guided Practice 2-1: Reviewing Job
Costs Using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify the value of scrap in your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of scrap in your job
4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job.

1.  Navigate to the WIP Value Summary window to
verify the value of scrap in your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of scrap in your job
4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job.
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Guided Practice 2-1: Performing
Completion Transactions

Guided Practice 2-1: Performing
Completion Transactions

1.  Complete the remaining assemblies into the finished
goods (FGI) subinventory.

(N) WIP Material Transactions > Completion Transactions
2.  Job: xx-job01
3.  Type: WIP assembly completion
4.  Date: Today’s date
5.  Job Quantity: 10
6.  Job Complete: 5
7.  Available to Complete: 3
8.  Choose: Transact
9.  Subinventory: Accept default
10. Final completion: X
11. Quantity: 3
12. Choose: Done

1.  Complete the remaining assemblies into the finished
goods (FGI) subinventory.

(N) WIP Material Transactions > Completion Transactions
2.  Job: xx-job01
3.  Type: WIP assembly completion
4.  Date: Today’s date
5.  Job Quantity: 10
6.  Job Complete: 5
7.  Available to Complete: 3
8.  Choose: Transact
9.  Subinventory: Accept default
10. Final completion: X
11. Quantity: 3
12. Choose: Done
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Guided Practice 2-1: Valuing CompletionsGuided Practice 2-1: Valuing Completions

1.  Navigate to the Material Transaction Distributions
window to verify that your final completions were
recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions >
Reason, Reference

2.  Item: AS62445
3.  Costed: Yes

1.  Navigate to the Material Transaction Distributions
window to verify that your final completions were
recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions >
Reason, Reference

2.  Item: AS62445
3.  Costed: Yes
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Guided Practice 2-1: Reviewing Job
Costs Using the WIP Value Summary
Guided Practice 2-1: Reviewing Job
Costs Using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components,

your additional components, your moves and your
completions in your job

4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job.
7.  Choose Cost Element: Resource
8.  Choose: Distributions
9.  Action: Verify the distributions of your job.

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components,

your additional components, your moves and your
completions in your job

4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job.
7.  Choose Cost Element: Resource
8.  Choose: Distributions
9.  Action: Verify the distributions of your job.
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Guided Practice 2-1: Verifying Item CostsGuided Practice 2-1: Verifying Item Costs

1.  Navigate to the Item Cost Details window to verify
the cost of your assembly under Cost Information.

(N) CST Item Costs > Item Costs

2.  Item: AS62445
3.  Choose: Find
4.  Choose: Open
5.  Action: Review Cost Information

1.  Navigate to the Item Cost Details window to verify
the cost of your assembly under Cost Information.

(N) CST Item Costs > Item Costs

2.  Item: AS62445
3.  Choose: Find
4.  Choose: Open
5.  Action: Review Cost Information
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Guided Practice 2-1: Closing Discrete
Jobs

Guided Practice 2-1: Closing Discrete
Jobs

1.  Navigate to the Close Discrete Jobs window to
close only your job.

(N) WIP Discrete > Close Discrete Jobs > Close Discrete Job
(SRS)

2.  Request Name: Close Discrete Jobs
3.  Parameters window
4.  Class Type:  Standard discrete
5.  From Job: xx-job01, where xx are your initials
6.  To Job: xx-job01, where xx are your initials
7.   OK
8.  Choose: Submit Request
9.  Record your request number here:__________

1.  Navigate to the Close Discrete Jobs window to
close only your job.

(N) WIP Discrete > Close Discrete Jobs > Close Discrete Job
(SRS)

2.  Request Name: Close Discrete Jobs
3.  Parameters window
4.  Class Type:  Standard discrete
5.  From Job: xx-job01, where xx are your initials
6.  To Job: xx-job01, where xx are your initials
7.   OK
8.  Choose: Submit Request
9.  Record your request number here:__________
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Guided Practice 2-1: Reviewing RequestsGuided Practice 2-1: Reviewing Requests

1.  Navigate to the Requests window to check to make
sure that your close request has completed.

CST (T) Help > Requests (T) Query your request number (B) View
Output

1.  Navigate to the Requests window to check to make
sure that your close request has completed.

CST (T) Help > Requests (T) Query your request number (B) View
Output
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using the WIP Value Summary

Guided Practice 2-1: Valuing Your Job
using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your job
4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job for each

cost element
7.  Choose Cost Element: Resource
8.  Choose: Distributions
9.  Action: Verify the accounting distributions of your

job created by the transactions.

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your job
4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job for each

cost element
7.  Choose Cost Element: Resource
8.  Choose: Distributions
9.  Action: Verify the accounting distributions of your

job created by the transactions.
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Guided Practice 2-1: Reviewing the
Discrete Job Value Report

1.  Run the Discrete Job Value Report for your job, and
review the results online.

(N) WIP Report (Select) Discrete Job Value Report
2.  Request Name: Discrete Job Value Report-Standard
3.  Parameters window
4.  Sort by:  Job
5.  Report Type: Summary
6.  Class Type: Standard Discrete
7.  Include Bulk: Yes
8.  Include Vendor: Yes
9.  From Job: xx-job01, where xx are your initials
10. To Job: xx-job01, where xx are your initials
11. OK and choose: Submit Request
12. Record your request number here:__________

1.  Run the Discrete Job Value Report for your job, and
review the results online.

(N) WIP Report (Select) Discrete Job Value Report
2.  Request Name: Discrete Job Value Report-Standard
3.  Parameters window
4.  Sort by:  Job
5.  Report Type: Summary
6.  Class Type: Standard Discrete
7.  Include Bulk: Yes
8.  Include Vendor: Yes
9.  From Job: xx-job01, where xx are your initials
10. To Job: xx-job01, where xx are your initials
11. OK and choose: Submit Request
12. Record your request number here:__________
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Guided Practice 2-1: Reviewing RequestsGuided Practice 2-1: Reviewing Requests

1.  Navigate to the Requests window to check to make
sure that your report has completed.

CST (T) Help > Requests (T) Query your request number (B) View
Output

1.  Navigate to the Requests window to check to make
sure that your report has completed.

CST (T) Help > Requests (T) Query your request number (B) View
Output
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Practice 2-2:
 Business Scenario for WIP Costing

In this practice, you have a business scenario for
WIP Costing, discussing the impact of
overcompletions, scrap and phantom costing.
• Finest Furniture is a manufacturer of casual

furniture.  Their product line consists of tables and
chairs.

• One of their biggest challenges is producing a
greater quantity than is on the work order.  The
furniture is made of wood and many times they
have realized a better yield than the expected yield
on the wood through the manufacturing process.

In this practice, you have a business scenario for
WIP Costing, discussing the impact of
overcompletions, scrap and phantom costing.
• Finest Furniture is a manufacturer of casual

furniture.  Their product line consists of tables and
chairs.

• One of their biggest challenges is producing a
greater quantity than is on the work order.  The
furniture is made of wood and many times they
have realized a better yield than the expected yield
on the wood through the manufacturing process.
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Practice 2-2:
 Business Scenario for WIP Costing

• For example, they anticipate being able to
manufacture 20 chairs from the quantity of wood
issued to WIP.

• However, because one or two pieces were longer
than the standard, Finest Furniture was able to
manufacture 25 chairs.

• Overcompletions provide a mechanism for Finest
Furniture to keep all the assemblies manufactured
at one time together with a minimal amount of
work.

• For example, they anticipate being able to
manufacture 20 chairs from the quantity of wood
issued to WIP.

• However, because one or two pieces were longer
than the standard, Finest Furniture was able to
manufacture 25 chairs.

• Overcompletions provide a mechanism for Finest
Furniture to keep all the assemblies manufactured
at one time together with a minimal amount of
work.
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Practice 2-2:
 Business Scenario for WIP Costing

• In addition, Finest Furniture occasionally has to
scrap a chair during the production process.
There is a way for the assembly pull components
to be issued to the job as a part of the scrap
transaction.

• They no longer need to manually issue assembly
pull components.

• Since the job status changes to complete once the
completed quantity plus the scrap quantity is
either equal to or greater than the job start
quantity, production managers have better
visibility as to which jobs are truly in process.

• In addition, Finest Furniture occasionally has to
scrap a chair during the production process.
There is a way for the assembly pull components
to be issued to the job as a part of the scrap
transaction.

• They no longer need to manually issue assembly
pull components.

• Since the job status changes to complete once the
completed quantity plus the scrap quantity is
either equal to or greater than the job start
quantity, production managers have better
visibility as to which jobs are truly in process.
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Practice 2-2:
 Business Scenario for WIP Costing

• Finally,  Finest Furniture uses phantoms and is
interested in seeing phantom costing of the work
order.

• AS62445 is an assembly that has been created in
Vision to demonstrate the features in release 11i.
Practice 2-2 will be completed using the M1
organization.

• Finally,  Finest Furniture uses phantoms and is
interested in seeing phantom costing of the work
order.

• AS62445 is an assembly that has been created in
Vision to demonstrate the features in release 11i.
Practice 2-2 will be completed using the M1
organization.
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In this practice, you are a cost accountant and you
define and process a discrete job from release to
completion. After performing WIP transactions, you
view the work order to verify material and resource
requirements and review the job value using the WIP
Value Summary window. This will help you to analyze
the impact of each transaction.
1.  Create a work order for a quantity of 100 for the

final assembly AS62445.  Once the work order has
been created, view the work order to verify that
material and resource requirements have been
created for the components and resources on the
phantom. Verify the overcompletion tolerance for
the final assembly AS62445.

In this practice, you are a cost accountant and you
define and process a discrete job from release to
completion. After performing WIP transactions, you
view the work order to verify material and resource
requirements and review the job value using the WIP
Value Summary window. This will help you to analyze
the impact of each transaction.
1.  Create a work order for a quantity of 100 for the

final assembly AS62445.  Once the work order has
been created, view the work order to verify that
material and resource requirements have been
created for the components and resources on the
phantom. Verify the overcompletion tolerance for
the final assembly AS62445.
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2.  Execute an easy completion using the move form
for a quantity of five greater than your work order
but less than the tolerance you set at the item
level. You will verify that the overcompletion
transaction costs the job based on the quantity of
assemblies transacted.

• Once the transactions have processed, view the
job to verify that the system charged to the job
components and resource hours based on total
quantity completed, not job start quantity.

2.  Execute an easy completion using the move form
for a quantity of five greater than your work order
but less than the tolerance you set at the item
level. You will verify that the overcompletion
transaction costs the job based on the quantity of
assemblies transacted.

• Once the transactions have processed, view the
job to verify that the system charged to the job
components and resource hours based on total
quantity completed, not job start quantity.
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• For each operation, you should see the hours
applied to the job being computed based on the
actual amount completed.  In addition, when you
view the resources for the operation with the
phantom, verify that hours applied for the
phantom resources have been computed based on
the actual amount completed.

• Verify that the costing of the overcompletion and
phantom resources is correct.

• Alternate between the summary level and the
detail level of the WIP Value Summary. Verify that
the phantom resources are considered this level
costs.

• For each operation, you should see the hours
applied to the job being computed based on the
actual amount completed.  In addition, when you
view the resources for the operation with the
phantom, verify that hours applied for the
phantom resources have been computed based on
the actual amount completed.

• Verify that the costing of the overcompletion and
phantom resources is correct.

• Alternate between the summary level and the
detail level of the WIP Value Summary. Verify that
the phantom resources are considered this level
costs.
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3.  Execute a scrap transaction for a quantity of five
and verify that the assembly pull components are
charged to the job.

3.  Execute a scrap transaction for a quantity of five
and verify that the assembly pull components are
charged to the job.
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Jobs

Guided Practice 2-3: Defining Discrete
Jobs

1.  Navigate to the Discrete Jobs window to define a
released, discrete job for AS62445, as follows:

(N) WIP Discrete > Discrete Jobs (B) New

2.  Job: xx-job02, where xx are your initials
3.  Type: Standard
4.  Assembly: AS62445
5.  Class: Discrete
6.  Status: Released
7.  Start quantity: 100
8.  MRP Net quantity: Defaults
9.  Firm: Clear
10.Start date: Today
11.Save and record the job number that the system
assigns here:_______

1.  Navigate to the Discrete Jobs window to define a
released, discrete job for AS62445, as follows:

(N) WIP Discrete > Discrete Jobs (B) New

2.  Job: xx-job02, where xx are your initials
3.  Type: Standard
4.  Assembly: AS62445
5.  Class: Discrete
6.  Status: Released
7.  Start quantity: 100
8.  MRP Net quantity: Defaults
9.  Firm: Clear
10.Start date: Today
11.Save and record the job number that the system
assigns here:_______
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Guided Practice 2-3: Verifying Material
and Resource Requirements on Phantom
Guided Practice 2-3: Verifying Material

and Resource Requirements on Phantom

1.  Verify that phantom resources and requirements
have been created for your job.

(N) Work in Process > Discrete Jobs > View Discrete Jobs

2.  Job: Your job xx-job02
3.  Choose Find
4.  Choose Operations
5.  Navigate to the operation that has the phantom
6.  Choose Resources
7.  Choose the Quantities tab
You should see your phantom resources and
requirements being created for them

1.  Verify that phantom resources and requirements
have been created for your job.

(N) Work in Process > Discrete Jobs > View Discrete Jobs

2.  Job: Your job xx-job02
3.  Choose Find
4.  Choose Operations
5.  Navigate to the operation that has the phantom
6.  Choose Resources
7.  Choose the Quantities tab
You should see your phantom resources and
requirements being created for them
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Overcompletion Tolerance for AS62445

Guided Practice 2-3: Verifying
Overcompletion Tolerance for AS62445

1.  Verify the overcompletion tolerance for the final
assembly AS62445.

(N) Inventory > Items > Organization Items

2.  Item: AS62445
3.  Choose Find
4.  Choose the Work-in-Process tab
5.  Make a note of the overcompletion tolerance type

and amount._____________

1.  Verify the overcompletion tolerance for the final
assembly AS62445.

(N) Inventory > Items > Organization Items

2.  Item: AS62445
3.  Choose Find
4.  Choose the Work-in-Process tab
5.  Make a note of the overcompletion tolerance type

and amount._____________
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Guided Practice 2-3: Performing Easy
Completions

Guided Practice 2-3: Performing Easy
Completions

1.  Perform an easy completion using the move window
for a quantity of five greater than your work order but
less than the tolerance you set at the item level. You will
verify that the overcompletion transaction costs the job
based on the quantity of assemblies transacted.
(N) WIP Move Transactions > Move Transactions
2.  Job: Your job xx-job02
3.  Complete: Yes
4.  From Op Seq: 10, Step Queue
5.  Overcompletion: X
6.  Quantity: an amount of five over the job quantity but
less than the tolerance
7.  Date:Today’s date
8.  Choose: Transact

1.  Perform an easy completion using the move window
for a quantity of five greater than your work order but
less than the tolerance you set at the item level. You will
verify that the overcompletion transaction costs the job
based on the quantity of assemblies transacted.
(N) WIP Move Transactions > Move Transactions
2.  Job: Your job xx-job02
3.  Complete: Yes
4.  From Op Seq: 10, Step Queue
5.  Overcompletion: X
6.  Quantity: an amount of five over the job quantity but
less than the tolerance
7.  Date:Today’s date
8.  Choose: Transact
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Jobs

Guided Practice 2-3: Viewing Discrete
Jobs

1.  Wait for the inventory and cost managers to run.
Once the transactions have processed, view the job
to verify that the system charged components and
resource hours based on total quantity completed,
not job start quantity.
(N) Work in Process > Discrete Jobs > View Discrete Jobs
2.  Job: Your job xx-job02
3.  Choose Find
4.  Choose Components
5.  Choose the Quantity tab
6.  Verify the number computed
7.  Return to the summary page
8.  Choose Operations
9.  Choose Resources
10.Choose Quantities

1.  Wait for the inventory and cost managers to run.
Once the transactions have processed, view the job
to verify that the system charged components and
resource hours based on total quantity completed,
not job start quantity.
(N) Work in Process > Discrete Jobs > View Discrete Jobs
2.  Job: Your job xx-job02
3.  Choose Find
4.  Choose Components
5.  Choose the Quantity tab
6.  Verify the number computed
7.  Return to the summary page
8.  Choose Operations
9.  Choose Resources
10.Choose Quantities
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Jobs

Guided Practice 2-3: Viewing Discrete
Jobs

• For each operation, you should see the hours
applied being computed based on the actual
amount completed.

• In addition, when you view the resources for the
operation with the phantom, verify that hours
applied for the phantom resources have been
computed based on the actual amount completed.

• For each operation, you should see the hours
applied being computed based on the actual
amount completed.

• In addition, when you view the resources for the
operation with the phantom, verify that hours
applied for the phantom resources have been
computed based on the actual amount completed.
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Costs Using the WIP Value Summary
Guided Practice 2-3: Reviewing Job
Costs Using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to verify
that the costing of the overcompletion and phantom
resources is correct and that phantom resources are
considered this level costs.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

2.  Job: Your job xx-job02
3.  Review the job costs by alternating between the

detail and summary information in the WIP Value
Summary window

4.  View the accounting distributions created by the
completions. Choose each cost element, and choose
distributions to verify the distributions of your job.

1.  Navigate to the WIP Value Summary window to verify
that the costing of the overcompletion and phantom
resources is correct and that phantom resources are
considered this level costs.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

2.  Job: Your job xx-job02
3.  Review the job costs by alternating between the

detail and summary information in the WIP Value
Summary window

4.  View the accounting distributions created by the
completions. Choose each cost element, and choose
distributions to verify the distributions of your job.
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Guided Practice 2-3: Performing Scrap
Transactions

Guided Practice 2-3: Performing Scrap
Transactions

1.  Execute a scrap transaction for a quantity of 5 and
verify that the assembly pull components are charged
to the job.
(N) Work in Process > Move Transactions > Move Transactions

2.  Job: Your job xx-job02
3.  Move: X
4.  From operation: 10 Step: Queue
5.  To operation: 20 Step: Scrap
8.  Overcompletion: X
9.  Choose Transact

1.  Execute a scrap transaction for a quantity of 5 and
verify that the assembly pull components are charged
to the job.
(N) Work in Process > Move Transactions > Move Transactions

2.  Job: Your job xx-job02
3.  Move: X
4.  From operation: 10 Step: Queue
5.  To operation: 20 Step: Scrap
8.  Overcompletion: X
9.  Choose Transact
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Jobs

Guided Practice 2-3: Viewing Discrete
Jobs

1. Wait for the inventory and cost managers to run.
Once the transactions have processed, verify that the
costs incurred reflect assembly pull material.
(N) Work in Process > Discrete Jobs > View Discrete Jobs

2.  Job: Your job xx-job02
3.  Choose Find
4.  Choose Components
5.  Choose the Quantities tab
Have the assembly pull components been issued?

1. Wait for the inventory and cost managers to run.
Once the transactions have processed, verify that the
costs incurred reflect assembly pull material.
(N) Work in Process > Discrete Jobs > View Discrete Jobs

2.  Job: Your job xx-job02
3.  Choose Find
4.  Choose Components
5.  Choose the Quantities tab
Have the assembly pull components been issued?
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Jobs

Guided Practice 2-3: Viewing Discrete
Jobs

1.  Verify the costing of the transaction.
(N) Work in Process > Discrete Jobs > WIP Value Summary

2.  Job: Your job xx-job02
3.  Choose Find
4.  Choose Value Summary
Do the costs incurred reflect the cost of the assembly
pull components?

1.  Verify the costing of the transaction.
(N) Work in Process > Discrete Jobs > WIP Value Summary

2.  Job: Your job xx-job02
3.  Choose Find
4.  Choose Value Summary
Do the costs incurred reflect the cost of the assembly
pull components?
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Standard CostingStandard Costing

Appendix A: Describing T-Accounts for Inventory
Transactions for Standard Costing

Appendix A: Describing T-Accounts for Inventory
Transactions for Standard Costing
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After completing this lesson, you should be able to:
• Describe T-Accounts for inventory transactions in

standard costing

After completing this lesson, you should be able to:
• Describe T-Accounts for inventory transactions in

standard costing

Ship goodsShip goodsReceive goodsReceive goodsPurchasesPurchases

IntransitIntransit AdjustmentsAdjustmentsDirectDirect
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• Describing T-Accounts for Inventory Transactions
in Standard Costing

• Describing T-Accounts for Inventory Transactions
in Standard Costing
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Transactions
• Inventory purchasing transactions
• Expense purchasing transactions using month-end

accruals
• Expense purchasing transactions using online

accruals
• Miscellaneous transactions
• Interorganization transfers using intransit inventory
• Direct interorganization transfers
• Customer shipment and return transactions
• Adjustment transactions
• Internal requisitions

Transactions
• Inventory purchasing transactions
• Expense purchasing transactions using month-end

accruals
• Expense purchasing transactions using online

accruals
• Miscellaneous transactions
• Interorganization transfers using intransit inventory
• Direct interorganization transfers
• Customer shipment and return transactions
• Adjustment transactions
• Internal requisitions
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T-AccountsT-Accounts

T-Accounts
• Graphical representation of the double-entry

accounting system
Double-entry Accounting System
• Whenever you process a transaction on the

production floor or in the stockroom, the
transaction results in a distribution being created
that will go to the general ledger.

• Every transaction creates debit and credit entries
that balance.

T-Accounts
• Graphical representation of the double-entry

accounting system
Double-entry Accounting System
• Whenever you process a transaction on the

production floor or in the stockroom, the
transaction results in a distribution being created
that will go to the general ledger.

• Every transaction creates debit and credit entries
that balance.
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Example
• You deliver 10 units at $15 from receiving

inspection to inventory. You credit receiving
inspection and debit inventory.

Example
• You deliver 10 units at $15 from receiving

inspection to inventory. You credit receiving
inspection and debit inventory.

 1500  1500

InventoryInventory
Receiving Receiving 
InspectionInspection
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Inventory Purchasing TransactionsInventory Purchasing Transactions

Example
• You are a stockroom specialist for Vision. In your job,

you receive material to inspection from suppliers and
deliver material to inventory.  When the material is
defective, you return it to the suppliers from receiving.

• The controller has asked your cost accountant for an
analysis of the accounting flows for the following
transactions:
– Purchase order receipt to inspection
– Delivery to inventory
– Return to vendor from receiving
– Invoice match and approval in Accounts Payable

Example
• You are a stockroom specialist for Vision. In your job,

you receive material to inspection from suppliers and
deliver material to inventory.  When the material is
defective, you return it to the suppliers from receiving.

• The controller has asked your cost accountant for an
analysis of the accounting flows for the following
transactions:
– Purchase order receipt to inspection
– Delivery to inventory
– Return to vendor from receiving
– Invoice match and approval in Accounts Payable
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Recording T Accounts for Inventory Purchasing
Transactions (on the following page)
• For requisition and PO approval, there are no

accounting entries.
1.  Purchase order receipt to receiving  

50 units at $10 (PO cost)
2.  Delivery to inventory

45 units at $20 (standard material cost)
45 units at 2 (standard material overhead cost)

3.  Return to vendor from receiving
  5 units at $10 (PO cost)
4.  Invoice match/approval in Accounts Payable

 45 units at $15 (Invoice cost)

Recording T Accounts for Inventory Purchasing
Transactions (on the following page)
• For requisition and PO approval, there are no

accounting entries.
1.  Purchase order receipt to receiving  

50 units at $10 (PO cost)
2.  Delivery to inventory

45 units at $20 (standard material cost)
45 units at 2 (standard material overhead cost)

3.  Return to vendor from receiving
  5 units at $10 (PO cost)
4.  Invoice match/approval in Accounts Payable

 45 units at $15 (Invoice cost)
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Inventory Purchasing Transactions
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Inventory Purchasing TransactionsInventory Purchasing Transactions

Receiving Receiving 
InspectionInspection Inv. A/PInv. A/P InventoryInventory

PurchasePurchase
PricePrice

VarianceVariance

1 500 500
2a
2b

450 900
  90

450

3 50   50
4 450

MaterialMaterial
OverheadOverhead

AbsorptionAbsorption

InvoiceInvoice
PricePrice

VarianceVariance
AccountsAccounts
Payable Payable 

2b 90

4 225 675
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Accruals
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Expense Purchasing Transactions
with Month-End Accruals

Expense Purchasing Transactions
with Month-End Accruals

Example
• You are an Accounts Payable manager for Vision. In

your job, you run the Purchasing Receipt Accrual-
Period End process to debit expense and credit the
expense AP accrual account.

• The controller has asked you for an analysis of the
accounting flows for expense purchasing
transactions with month-end accruals, including the
following:
– Purchase order receipt accrual
– Reverse accrual after opening the next period
– Invoice match and approval in Accounts Payable

Example
• You are an Accounts Payable manager for Vision. In

your job, you run the Purchasing Receipt Accrual-
Period End process to debit expense and credit the
expense AP accrual account.

• The controller has asked you for an analysis of the
accounting flows for expense purchasing
transactions with month-end accruals, including the
following:
– Purchase order receipt accrual
– Reverse accrual after opening the next period
– Invoice match and approval in Accounts Payable
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Expense Purchasing Transactions with Month-End
Accruals
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Expense Purchasing Transactions
with Month-End Accruals

Expense Purchasing Transactions
with Month-End Accruals

Recording T Accounts for Expense Purchasing
Transactions (on the following page)
• For requisition, purchase order approval, and

receipt to inspection, there are no accounting
entries.

1.  Purchasing receipt accrual  
 50 units at $10 (Purchase order cost)

2.  Open next period in Purchasing
 Reverse accrual

3.  Invoice match/approval in Accounts Payable
 50 units at $15 (Invoice cost)

Recording T Accounts for Expense Purchasing
Transactions (on the following page)
• For requisition, purchase order approval, and

receipt to inspection, there are no accounting
entries.

1.  Purchasing receipt accrual  
 50 units at $10 (Purchase order cost)

2.  Open next period in Purchasing
 Reverse accrual

3.  Invoice match/approval in Accounts Payable
 50 units at $15 (Invoice cost)
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Expense Purchasing Transactions with Month-End
Accruals
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Expense Purchasing Transactions
with Month-End Accruals

Expense Purchasing Transactions
with Month-End Accruals

Receiving Receiving 
InspectionInspection

ExpenseExpense
A/PA/P

AccrualAccrual ExpenseExpense
AccountsAccounts
PayablePayable

Period 1
1 500 500

Period 2
2 500 500

3 750 750
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Expense Purchasing Transactions  with Accruals upon
Receipt
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Expense Purchasing Transactions
 with Accruals upon Receipt

Expense Purchasing Transactions
 with Accruals upon Receipt

Example
• You are an Accounts Payable manager for Vision.

In your job, because you accrue expense
purchases upon receipt, you have more entries to
reconcile in your AP accrual accounts.

• You should reclassify the expense portion of your
Receiving Inspection account balance at period
end.
– You can use the Receiving Value Report by

Destination Account to do this.
– You can avoid this step by receiving all

expense items as direct receipts.

Example
• You are an Accounts Payable manager for Vision.

In your job, because you accrue expense
purchases upon receipt, you have more entries to
reconcile in your AP accrual accounts.

• You should reclassify the expense portion of your
Receiving Inspection account balance at period
end.
– You can use the Receiving Value Report by

Destination Account to do this.
– You can avoid this step by receiving all

expense items as direct receipts.
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Expense Purchasing Transactions  with Accruals upon
Receipt
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Expense Purchasing Transactions
 with Accruals upon Receipt

Expense Purchasing Transactions
 with Accruals upon Receipt

Example (continued)
• The controller has asked you for an analysis of the

accounting flows for expense purchasing
transactions upon receipt, including the following:
– Purchase order receipt to inspection
– Period end manual entry to reclassify
– Reverse accrual after opening the next period
– Delivery to destination
– Invoice match and approval in Accounts

Payable

Example (continued)
• The controller has asked you for an analysis of the

accounting flows for expense purchasing
transactions upon receipt, including the following:
– Purchase order receipt to inspection
– Period end manual entry to reclassify
– Reverse accrual after opening the next period
– Delivery to destination
– Invoice match and approval in Accounts

Payable
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Expense Purchasing Transactions  with Accruals upon
Receipt
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Expense Purchasing Transactions
 with Accruals upon Receipt

Expense Purchasing Transactions
 with Accruals upon Receipt

Recording T Accounts for Expense Purchasing
Transactions (on the following page)
• For requisition and purchase order approval, there

are no accounting entries.
1.  Purchase order receipt to inspection  

 50 units at $10 (Purchase order cost)
2.  Period end manual entry to reclassify

 Reverse journal
3.  Open next period in General Ledger

 Reverse accrual
4.  Delivery to destination

 50 units at $10 (Purchase order cost)
5.  Invoice match/approval in Accounts Payable

   50 units at $15 (Invoice cost)

Recording T Accounts for Expense Purchasing
Transactions (on the following page)
• For requisition and purchase order approval, there

are no accounting entries.
1.  Purchase order receipt to inspection  

 50 units at $10 (Purchase order cost)
2.  Period end manual entry to reclassify

 Reverse journal
3.  Open next period in General Ledger

 Reverse accrual
4.  Delivery to destination

 50 units at $10 (Purchase order cost)
5.  Invoice match/approval in Accounts Payable

   50 units at $15 (Invoice cost)
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Expense Purchasing Transactions  with Accruals upon
Receipt
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Expense Purchasing Transactions
 with Accruals upon Receipt

Expense Purchasing Transactions
 with Accruals upon Receipt

Receiving Receiving 
InspectionInspection

ExpenseExpense
A/PA/P

AccrualAccrual ExpenseExpense
Accounts Accounts 
PayablePayable

Period 1
1 500 500

2 500 500
Period 2
3

500
500

4 500 500
5 500 250 750
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Miscellaneous Inventory Transactions
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Miscellaneous Inventory TransactionsMiscellaneous Inventory Transactions

Example
• You are a stockroom clerk for Vision. You are

responsible for ensuring that inventory resides in
correct subinventories and correct accounts.

• In your job, you do the following:
– You perform subinventory to subinventory

transfers.
– You issue material from a subinventory to a

general ledger account or to an account alias.
– You receive material to a subinventory from a

general ledger account or from an account
alias.

Example
• You are a stockroom clerk for Vision. You are

responsible for ensuring that inventory resides in
correct subinventories and correct accounts.

• In your job, you do the following:
– You perform subinventory to subinventory

transfers.
– You issue material from a subinventory to a

general ledger account or to an account alias.
– You receive material to a subinventory from a

general ledger account or from an account
alias.
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Miscellaneous Inventory Transactions
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Miscellaneous Inventory TransactionsMiscellaneous Inventory Transactions

Example
• The controller has asked your cost accountant for

an analysis of the accounting flows for the
following miscellaneous inventory transactions:
– Subinventory to subinventory transfer
– Miscellaneous issue to expense account
– Miscellaneous receipt from expense account
– Miscellaneous issue to account alias
– Miscellaneous receipt from account alias

Example
• The controller has asked your cost accountant for

an analysis of the accounting flows for the
following miscellaneous inventory transactions:
– Subinventory to subinventory transfer
– Miscellaneous issue to expense account
– Miscellaneous receipt from expense account
– Miscellaneous issue to account alias
– Miscellaneous receipt from account alias
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Miscellaneous Inventory Transactions

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Miscellaneous Inventory TransactionsMiscellaneous Inventory Transactions

Recording T Accounts for Miscellaneous Inventory
Transactions (on the following page)
1. Subinventory to subinventory transfer  

 50 units at $10 (Standard cost)
2. Miscellaneous issue to expense account

 10 units at $10 (Standard cost)
3. Miscellaneous receipt from expense account

 20 units at $10 (Standard cost)
4. Miscellaneous issue to account alias

 30 units at $10 (Standard cost)
5. Miscellaneous receipt from account alias 

   40 units at $10 (Standard cost)

Recording T Accounts for Miscellaneous Inventory
Transactions (on the following page)
1. Subinventory to subinventory transfer  

 50 units at $10 (Standard cost)
2. Miscellaneous issue to expense account

 10 units at $10 (Standard cost)
3. Miscellaneous receipt from expense account

 20 units at $10 (Standard cost)
4. Miscellaneous issue to account alias

 30 units at $10 (Standard cost)
5. Miscellaneous receipt from account alias 

   40 units at $10 (Standard cost)
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Miscellaneous Inventory Transactions
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Miscellaneous Inventory TransactionsMiscellaneous Inventory Transactions

Inventory Inventory 
Sub1Sub1

InventoryInventory
Sub2Sub2 ExpenseExpense

Account Account 
AliasAlias

1 500 500

2 100 100

3 200 200

4 300 300

5 400 400
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Direct Interorganization Transfers
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Direct Interorganization TransfersDirect Interorganization Transfers

Example
• You are a stockroom clerk for Vision. In your job,

you receive direct interorganization transfers.
• The controller has asked your cost accountant for

an analysis of the accounting flows for the
following transactions:
– Direct interorganization transfer transaction
– Receipt transaction

Example
• You are a stockroom clerk for Vision. In your job,

you receive direct interorganization transfers.
• The controller has asked your cost accountant for

an analysis of the accounting flows for the
following transactions:
– Direct interorganization transfer transaction
– Receipt transaction
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Direct Interorganization Transfers
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Direct Interorganization TransfersDirect Interorganization Transfers

Recording T Accounts for Direct Interorganization
Transfers (on the following page)
• Direct interorganization transfers automatically

perform the issue and receipt transactions.
   Sending          Receiving

Organization       Organization

Standard cost $10.00 $15.00
Transfer credit 10%
Freight $10.00
Costing method   Standard costing   Standard costing
Transaction: Transfer 50 units between organizations

Recording T Accounts for Direct Interorganization
Transfers (on the following page)
• Direct interorganization transfers automatically

perform the issue and receipt transactions.
   Sending          Receiving

Organization       Organization

Standard cost $10.00 $15.00
Transfer credit 10%
Freight $10.00
Costing method   Standard costing   Standard costing
Transaction: Transfer 50 units between organizations
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Interorganization Transfers  Using Intransit FOB
Receipt
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Interorganization Transfers
Using Intransit FOB Receipt
Interorganization Transfers
Using Intransit FOB Receipt

Example
• You are a stockroom clerk for Vision. In your job,

you receive interorganization transfers using
intransit FOB receipts.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following transactions:
– Intransit interorganization transfer transaction
– Receipt transaction

Example
• You are a stockroom clerk for Vision. In your job,

you receive interorganization transfers using
intransit FOB receipts.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following transactions:
– Intransit interorganization transfer transaction
– Receipt transaction
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Interorganization Transfers  Using Intransit FOB
Receipt

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Interorganization Transfers
Using Intransit FOB Receipt
Interorganization Transfers
Using Intransit FOB Receipt

Recording T Accounts for Interorganization Transfers
Using Intransit FOB Receipt (on the following page)

   Sending          Receiving
Organization       Organization

Standard cost $10.00          $15.00
Transfer credit 10%
Freight $10.00
Costing method   Standard costing   Standard costing

Transactions:
1. Transfer transaction   50 units
2. Receipt transaction   50 units

Recording T Accounts for Interorganization Transfers
Using Intransit FOB Receipt (on the following page)

   Sending          Receiving
Organization       Organization

Standard cost $10.00          $15.00
Transfer credit 10%
Freight $10.00
Costing method   Standard costing   Standard costing

Transactions:
1. Transfer transaction   50 units
2. Receipt transaction   50 units
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Interorganization Transfers Using Intransit FOB Receipt
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Interorganization Transfers
Using Intransit FOB Receipt
Interorganization Transfers
Using Intransit FOB Receipt

Sending organization accounts:Sending organization accounts:

1 500 500

2 500 560 50 10

2 750 560 190

Receiving organization accounts:Receiving organization accounts:

InterorgInterorg
PayablePayableInventoryInventory

InterorgInterorg
PVCPVC

InventoryInventory
TransferTransfer
CreditCredit

InterorgInterorg
ReceivableReceivable

FreightFreight
CreditCredit

Intransit Intransit 
InventoryInventory
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Interorganization Transfers  Using Intransit FOB
Shipment
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Interorganization Transfers
Using Intransit FOB Shipment
Interorganization Transfers

Using Intransit FOB Shipment

Example
• You are a stockroom clerk for Vision. In your job,

you receive interorganization transfers using
intransit FOB shipment.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following transactions:
– Intransit interorganization transfer transaction
– Receipt transaction

Example
• You are a stockroom clerk for Vision. In your job,

you receive interorganization transfers using
intransit FOB shipment.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following transactions:
– Intransit interorganization transfer transaction
– Receipt transaction
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Interorganization Transfers  Using Intransit FOB
Shipment
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Interorganization Transfers
Using Intransit FOB Shipment
Interorganization Transfers

Using Intransit FOB Shipment

Recording T Accounts for Interorganization Transfers
Using Intransit FOB Shipment (on the following page)

   Sending          Receiving
Organization       Organization

Standard cost $10.00                    $15.00
Transfer credit 10%
Freight $10.00
Costing method Standard costing   Standard costing

Transactions:
1. Transfer transaction   50 units
2. Receipt transaction   50 units

Recording T Accounts for Interorganization Transfers
Using Intransit FOB Shipment (on the following page)

   Sending          Receiving
Organization       Organization

Standard cost $10.00                    $15.00
Transfer credit 10%
Freight $10.00
Costing method Standard costing   Standard costing

Transactions:
1. Transfer transaction   50 units
2. Receipt transaction   50 units
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Interorganization Transfers Using Intransit FOB
Shipment
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Interorganization Transfers
Using Intransit FOB Shipment
Interorganization Transfers

Using Intransit FOB Shipment

Sending organization accounts:Sending organization accounts:

Receiving organization accounts:Receiving organization accounts:

InventoryInventory
InterorgInterorg

ReceivableReceivable

1 500 550 50

IntransitIntransit
InventoryInventory InventoryInventory

InterorgInterorg
PayablePayable

InterorgInterorg
PPVPPV

FreightFreight
CreditCredit

1 750 550 190 10

2 750 750

TransferTransfer
CreditCredit
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Customer Shipments and Returns
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Customer Shipments and ReturnsCustomer Shipments and Returns

Example
• You are a shipping clerk for Vision. In your job,

you ship material from FGI to customers.
• The controller has asked your cost accountant for

an analysis of the accounting flows for the
following transactions:
– Shipment to customer
– Invoice customer 
– Return from customer 
– Issue credit memo to customer

Example
• You are a shipping clerk for Vision. In your job,

you ship material from FGI to customers.
• The controller has asked your cost accountant for

an analysis of the accounting flows for the
following transactions:
– Shipment to customer
– Invoice customer 
– Return from customer 
– Issue credit memo to customer
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Customer Shipments and Returns
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Customer Shipments and ReturnsCustomer Shipments and Returns

Recording T Accounts for Customer Shipments
(on the following page)
Customer Shipments
1. Shipment to customer

50 units at $10 (standard cost)
2. Invoice customer 

50 units at $15 (price)
3. Return from customer 

 10 units at $10 (standard cost)
4. Issue credit memo to customer

   10 units at $15 (price)

Recording T Accounts for Customer Shipments
(on the following page)
Customer Shipments
1. Shipment to customer

50 units at $10 (standard cost)
2. Invoice customer 

50 units at $15 (price)
3. Return from customer 

 10 units at $10 (standard cost)
4. Issue credit memo to customer

   10 units at $15 (price)
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Customer Shipments and ReturnsCustomer Shipments and Returns

InventoryInventory COGSCOGS RevenueRevenue
AccountsAccounts

ReceivableReceivable

1 500 500

2 750 750

3 100 100

4 150 150
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Inventory Adjustments

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Inventory AdjustmentsInventory Adjustments

Example
• You are a stockroom clerk for Vision. In your job,

you cycle count valuable items in subinventories
once a quarter. You also perform a physical
inventory of all asset items in subinventories once
a year.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following transactions:
– Cycle count adjustment
– Physical inventory adjustment  

Example
• You are a stockroom clerk for Vision. In your job,

you cycle count valuable items in subinventories
once a quarter. You also perform a physical
inventory of all asset items in subinventories once
a year.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following transactions:
– Cycle count adjustment
– Physical inventory adjustment  
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Inventory Adjustments
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Inventory AdjustmentsInventory Adjustments

Recording T Accounts for Inventory Adjustments
1. Cycle count adjustment

-5 units at $20 (standard cost)
2. Physical inventory adjustment 

10 units at $30 (price)

Recording T Accounts for Inventory Adjustments
1. Cycle count adjustment

-5 units at $20 (standard cost)
2. Physical inventory adjustment 

10 units at $30 (price)

InventoryInventory
InventoryInventory

AdjustmentAdjustment

1 100 100

2 300 300
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SummarySummary

In this lesson, you should have learned how to:
• Describe T-Accounts for inventory transactions in

standard costing

In this lesson, you should have learned how to:
• Describe T-Accounts for inventory transactions in

standard costing

Ship goodsShip goodsReceive goodsReceive goodsPurchasesPurchases

IntransitIntransit AdjustmentsAdjustmentsDirectDirect
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Practice 1 OverviewPractice 1 Overview

This practice covers the following topics:
• Recording postings for an inventory purchasing

flow
• Recording postings for transfer and receipt

transactions

This practice covers the following topics:
•• Recording postings for an inventory purchasingRecording postings for an inventory purchasing

flowflow
•• Recording postings for transfer and receiptRecording postings for transfer and receipt

transactionstransactions
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Practice 1-1: Recording Postings for an Inventory
Purchasing Flow
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Practice 1-1: Recording Postings for an
Inventory Purchasing Flow

Practice 1-1: Recording Postings for an
Inventory Purchasing Flow

In this practice, you record the postings for an
inventory purchasing flow.
• You are the cost accountant for Vision in Seattle.

The controller has asked you for an analysis of the
purchasing process. He wants to understand the
accounting flows for purchasing receipts to
inspection and deliveries to inventory and for
invoice matching and approval.

In this practice, you record the postings for an
inventory purchasing flow.
• You are the cost accountant for Vision in Seattle.

The controller has asked you for an analysis of the
purchasing process. He wants to understand the
accounting flows for purchasing receipts to
inspection and deliveries to inventory and for
invoice matching and approval.
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Practice 1-1: Recording Postings for an Inventory
Purchasing Flow
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Practice 1-1: Recording Postings for an
Inventory Purchasing Flow

Practice 1-1: Recording Postings for an
Inventory Purchasing Flow

Recording T Accounts for Inventory Purchasing
Transactions (on the following page)
• For requisition and PO approval, there are no

accounting entries.
1.  Purchase order receipt to receiving  

10 units at $15 (purchase order price)
2.  Delivery to inventory

10 units at $20 (standard material cost)
10 units at 2 (standard material overhead cost)

3.  Invoice match/approval in Accounts Payable
 10 units at $18 (Invoice cost)

Recording T Accounts for Inventory Purchasing
Transactions (on the following page)
• For requisition and PO approval, there are no

accounting entries.
1.  Purchase order receipt to receiving  

10 units at $15 (purchase order price)
2.  Delivery to inventory

10 units at $20 (standard material cost)
10 units at 2 (standard material overhead cost)

3.  Invoice match/approval in Accounts Payable
 10 units at $18 (Invoice cost)
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Practice 1-1: Recording Postings for an Inventory
Purchasing Flow
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Practice 1-1: Recording Postings for an
Inventory Purchasing Flow

Practice 1-1: Recording Postings for an
Inventory Purchasing Flow

Quantity  PO  Standard  Standard   Invoice   Invoice
Received Price  Material  Mat’l MOH Quantity Price
10    15.00  20.00  2.00   10     18.00

Quantity  PO  Standard  Standard   Invoice   Invoice
Received Price  Material  Mat’l MOH Quantity Price
10    15.00  20.00  2.00   10     18.00

InventoryInventory
A/PA/P
AccrualAccrual

PurchasePurchase
PricePrice
VarianceVariance

Receiving Receiving 
InspectionInspection InventoryInventory

MOHMOH
AbsorptionAbsorption

Receipt to   Receipt to   
inspectioninspection

AccountsAccounts
PayablePayable

InvoiceInvoice
PricePrice
VarianceVariance

Deliver to Deliver to 
inventoryinventory

Invoice Invoice 
Match/Match/
ApprovalApproval
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Practice 1-1 Solution: Recording Postings for an
Inventory Purchasing Flow
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Practice 1-1 Solution: Recording Postings
for an Inventory Purchasing Flow

Practice 1-1 Solution: Recording Postings
for an Inventory Purchasing Flow

Quantity  PO  Standard  Standard   Invoice   Invoice
Received Price  Material  Mat’l MOH Quantity Price
10    15.00  20.00  2.00   10     18.00

Quantity  PO  Standard  Standard   Invoice   Invoice
Received Price  Material  Mat’l MOH Quantity Price
10    15.00  20.00  2.00   10     18.00

InventoryInventory
A/PA/P
AccrualAccrual

PurchasePurchase
PricePrice
VarianceVariance

Receiving Receiving 
InspectionInspection InventoryInventory

MOHMOH
AbsorptionAbsorption

Receipt to   Receipt to   
inspectioninspection

AccountsAccounts
PayablePayable

InvoiceInvoice
PricePrice
VarianceVariance

Deliver to Deliver to 
inventoryinventory

Invoice Invoice 
Match/Match/
ApprovalApproval

 150

 150

 150

 150

 220  50  20

 30  180
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Receipt Transactions
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Practice 1-2: Recording Postings for
Transfer and Receipt Transactions

Practice 1-2: Recording Postings for
Transfer and Receipt Transactions

In this practice, you record postings for transfer and
receipt transactions.
• You are the cost accountant for Vision. The

controller has asked you for an analysis of the
Oracle Manufacturing system. He wants to
understand the accounting flows for
interorganization transfers.

In this practice, you record postings for transfer andrecord postings for transfer and
receipt transactionsreceipt transactions.
• You are the cost accountant for Vision. The

controller has asked you for an analysis of the
Oracle Manufacturing system. He wants to
understand the accounting flows for
interorganization transfers.
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Receipt Transactions
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Practice 1-2: Recording Postings for
Transfer and Receipt Transactions

Practice 1-2: Recording Postings for
Transfer and Receipt Transactions

In this practice, you do the following:
1.  Transfer 10 Sentinel Multimedia systems from Seattle

to Chicago.
2.  Use intransit inventory.
3.  Use FOB point of receipt.
4.  Add transfer charges of 1%.
5.  Add a freight charge of 100.00.
6.  Look up the standard cost of the item in each

organization. You find that the cost in Seattle is 1500.00
and the cost in Chicago is 1600.00.

In this practice, you do the following:
1.  Transfer 10 Sentinel Multimedia systems from Seattle

to Chicago.
2.  Use intransit inventory.
3.  Use FOB point of receipt.
4.  Add transfer charges of 1%.
5.  Add a freight charge of 100.00.
6.  Look up the standard cost of the item in each

organization. You find that the cost in Seattle is 1500.00
and the cost in Chicago is 1600.00.
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Receipt Transactions
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Practice 1-2: Recording Postings for
Transfer and Receipt Transactions

Practice 1-2: Recording Postings for
Transfer and Receipt Transactions

Assumptions
Standard Cost Transfer Credit Freight
Sending organization  1500.00 1% 100.00
Receiving organization  1600.00
1.  Transfer transaction 10 units
2.  Receipt transaction 10 units

Assumptions
Standard Cost Transfer Credit Freight
Sending organization  1500.00 1% 100.00
Receiving organization  1600.00
1.  Transfer transaction 10 units
2.  Receipt transaction 10 units
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Practice 1-2: Recording Postings for
Transfer and Receipt Transactions

Practice 1-2: Recording Postings for
Transfer and Receipt Transactions

Use the following transfer accounts to prepare the
account postings for both Seattle and Chicago for both
the transfer and the receipt transactions.

Use the following transfer accounts to prepare the
account postings for both Seattle and Chicago for both
the transfer and the receipt transactions.

FreightFreight
CreditCredit

Transfer Transfer 
CreditCredit

Intransit Intransit 
InventoryInventory

InterorgInterorg
ReceivableReceivableInventoryInventory

1

2

Seattle Seattle 
accounts:accounts:

InventoryInventory
InterorgInterorg
PVCPVC

InterorgInterorg  
PayablePayable

1

Chicago Chicago 
accounts:accounts:
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Practice 1-2 Solution: Recording Postings
for Transfer and Receipt Transactions

Practice 1-2 Solution: Recording Postings
for Transfer and Receipt Transactions

Use the following transfer accounts to prepare the
account postings for both Seattle and Chicago for both
the transfer and the receipt transactions.

Use the following transfer accounts to prepare the
account postings for both Seattle and Chicago for both
the transfer and the receipt transactions.

FreightFreight
CreditCredit

Transfer Transfer 
CreditCredit

Intransit Intransit 
InventoryInventory

InterorgInterorg
ReceivableReceivable

 15000

 15000

 15000

 15250

InventoryInventory

1

2

Seattle Seattle 
accounts:accounts:

InventoryInventory
InterorgInterorg
PVCPVC

 16000  15250

InterorgInterorg  
PayablePayable

1

Chicago Chicago 
accounts:accounts:

 150  100

 750
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Appendix B: Describing T-
Accounts for WIP
Transactions for Standard
Costing
Chapter 4
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Standard Costing
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 Standard Costing Standard Costing

Appendix B: Describing T-Accounts for WIP
Transactions for Standard Costing

Appendix B: Describing T-Accounts for WIP
Transactions for Standard Costing
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ObjectivesObjectives

After completing this lesson, you should be able
to do the following:
• Describe T-Accounts for WIP transactions in

standard costing

After completing this lesson, you should be able
to do the following:
• Describe T-Accounts for WIP transactions in

standard costing
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AgendaAgenda

• Describing T-Accounts for WIP Transactions in
Standard Costing

• Describing T-Accounts for WIP Transactions in
Standard Costing
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OverviewOverview

   ResourcesResources

OSPOSP

 $ $

AssembliesAssemblies

CostCost
IncurredIncurred
($)($)

CostCost
RelievedRelieved
($)($)

NetNet ValueValue ==
IncurredIncurred -- RelievedRelieved

OverheadOverhead

ComponentsComponents

 $ $

 $ $

 $ $

WIPWIP

 $ $

Cost always follows quantityCost always follows quantity



Copyright © Oracle Corporation, 2000. All rights reserved.

Appendix B: Describing T-Accounts for WIP Transactions for Standard Costing
Chapter 4 - Page 6

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Overview

Raw materialRaw material
subinventorysubinventory

Oracle CostOracle Cost
ManagementManagement

Finished goodsFinished goods
subinventorysubinventory

Oracle Work inOracle Work in
ProcessProcess

Jobs and schedulesJobs and schedules
FinishedFinished

assembliesassemblies

Issue material;  relieve inventory and charge WIP at standard costIssue material;  relieve inventory and charge WIP at standard costIssue material;  relieve inventory and charge WIP at standard cost



Copyright © Oracle Corporation, 2000. All rights reserved.

Appendix B: Describing T-Accounts for WIP Transactions for Standard Costing
Chapter 4 - Page 7

Accounting Flows: Costs Incurred, Components Issued
to WIP
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Accounting Flows: Costs Incurred,
Components Issued to WIP

Accounting Flows: Costs Incurred,
Components Issued to WIP

Example
• You are a stockroom clerk for Vision. In your job,

you stage workorders, issuing push components
to jobs.  You also replace defective components
with substitute components.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following WIP material transactions:
– Issues of all push components
– Returns of specific components
– Issues of specific components

Example
• You are a stockroom clerk for Vision. In your job,

you stage workorders, issuing push components
to jobs.  You also replace defective components
with substitute components.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following WIP material transactions:
– Issues of all push components
– Returns of specific components
– Issues of specific components
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Accounting Flows: Costs Incurred,
Components Issued to WIP

Accounting Flows: Costs Incurred,
Components Issued to WIP

Recording T Accounts for Transactions (on the next page)
1.  WIP material transaction (issue all material)

Push all components into the job.
10 units at standard cost of $250 = $2,500.

2.  WIP material transaction (return specific component)
Return two defective units of component 2 to inventory.
2 units at standard cost of $33 = $66.

3.  WIP material transaction (issue specific component)
Replace defective components with substitute items.
2 units at standard cost of $40 = $80.

Recording T Accounts for Transactions (on the next page)
1.  WIP material transaction (issue all material)

Push all components into the job.
10 units at standard cost of $250 = $2,500.

2.  WIP material transaction (return specific component)
Return two defective units of component 2 to inventory.
2 units at standard cost of $33 = $66.

3.  WIP material transaction (issue specific component)
Replace defective components with substitute items.
2 units at standard cost of $40 = $80.
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to WIP
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Accounting Flows: Costs Incurred,
Components Issued to WIP

Accounting Flows: Costs Incurred,
Components Issued to WIP

Material transactions record the component cost of
material used in WIP.
1. WIP material transaction (issue all material)
2. WIP material transaction (return specific component)
3. WIP material transaction (issue specific component)

Material transactions record the component cost of
material used in WIP.
1. WIP material transaction (issue all material)
2. WIP material transaction (return specific component)
3. WIP material transaction (issue specific component)

1

2             66

3 80   80

2,500      2,500

  66

InventoryInventory
AccountsAccounts

WIPWIP
AccountsAccounts

Material TransactionsMaterial Transactions
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Accounting Flows: Costs Incurred,  Resource Charges
to WIP
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Accounting Flows: Costs Incurred,
Resource Charges to WIP

Accounting Flows: Costs Incurred,
Resource Charges to WIP

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you build
assemblies on workorders, charging resources to
jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor resource transactions:
– Resource transaction without rate variance
– Resource transaction reversal
– Resource transaction with rate variance

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you build
assemblies on workorders, charging resources to
jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor resource transactions:
– Resource transaction without rate variance
– Resource transaction reversal
– Resource transaction with rate variance
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Accounting Flows: Costs Incurred,  Resource Charges
to WIP
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Accounting Flows: Costs Incurred,
Resource Charges to WIP

Accounting Flows: Costs Incurred,
Resource Charges to WIP

Recording T Accounts for Transactions (on the next
page)

4.  Shop floor transaction (resource without rate variance)
     Charge resource RS1 at actual for operation 10.
     11 hours at $50 = $550.
5.  Shop floor transaction (reverse resource charge)

Reverse overcharge.
1 hour at $50 = $50.

6.  Shop floor transaction (resource with rate variance)
Charge resource RS2 at standard for operation 20.
5 units at $25 = $125.

Recording T Accounts for Transactions (on the next
page)

4.  Shop floor transaction (resource without rate variance)
     Charge resource RS1 at actual for operation 10.
     11 hours at $50 = $550.
5.  Shop floor transaction (reverse resource charge)

Reverse overcharge.
1 hour at $50 = $50.

6.  Shop floor transaction (resource with rate variance)
Charge resource RS2 at standard for operation 20.
5 units at $25 = $125.
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to WIP
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Accounting Flows: Costs Incurred,
Resource Charges to WIP

Accounting Flows: Costs Incurred,
Resource Charges to WIP

Resource transactions record the internal cost to
convert raw material into finished assemblies.
4. Shop floor transaction (resource without rate

variance)
5. Shop floor transaction (reverse resource charge)
6. Shop floor transaction (resource with rate variance)

Resource transactions record the internal cost to
convert raw material into finished assemblies.
4. Shop floor transaction (resource without rate

variance)
5. Shop floor transaction (reverse resource charge)
6. Shop floor transaction (resource with rate variance)

4

5

6

                      Resource Transactions                      Resource Transactions

125

50

WIPWIP
AccountsAccounts

ResourceResource
AbsorptionAbsorption

550 550

50

125

SubinventorySubinventory
AccountsAccounts

RateRate
VarianceVariance

25
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Accounting Flows: Costs Incurred,
Overhead Charges to WIP

Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you move
assemblies on workorders. When you move
assemblies, the system charges overhead costs
automatically based on resource units or value or
by item or lot.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor overhead transactions:
– Resource-based overhead transaction
– Resource-based overhead transaction reversal
– Item-based overhead transaction

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you move
assemblies on workorders. When you move
assemblies, the system charges overhead costs
automatically based on resource units or value or
by item or lot.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor overhead transactions:
– Resource-based overhead transaction
– Resource-based overhead transaction reversal
– Item-based overhead transaction
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Accounting Flows: Costs Incurred, Overhead Charges
to WIP
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Accounting Flows: Costs Incurred,
Overhead Charges to WIP

Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Recording T Accounts for Transactions (on the next page)
7.   Shop floor transaction (resource-based overhead)

 Charge 250% on the resource charged in step 4.
 $550 * 250% = $1,375.

8.   Shop floor transaction (reverse resource-based
      overhead)

 Reverse overhead for resource reversed in step 5.
 $50 * 250% = $125.

9.   Shop floor transaction (item-based overhead)
 Move through operation 20; charge item-based

      overhead.
 10 units at $20 = $200.

Recording T Accounts for Transactions (on the next page)
7.   Shop floor transaction (resource-based overhead)

 Charge 250% on the resource charged in step 4.
 $550 * 250% = $1,375.

8.   Shop floor transaction (reverse resource-based
      overhead)

 Reverse overhead for resource reversed in step 5.
 $50 * 250% = $125.

9.   Shop floor transaction (item-based overhead)
 Move through operation 20; charge item-based

      overhead.
 10 units at $20 = $200.
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to WIP
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Accounting Flows: Costs Incurred,
Overhead Charges to WIP

Accounting Flows: Costs Incurred,
Overhead Charges to WIPOverhead Charges to WIP

Overhead transactions record the indirect cost of WIP.
7. Shop floor transaction (resource-based overhead)
8. Shop floor transaction (reverse resource-based

overhead)
9. Shop floor transaction (item-based overhead)

Overhead transactions record the indirect cost of WIP.
7. Shop floor transaction (resource-based overhead)
8. Shop floor transaction (reverse resource-based

overhead)
9. Shop floor transaction (item-based overhead)

Overhead TransactionsOverhead Transactions

7

8

9

WIPWIP
AccountsAccounts

OverheadOverhead
AbsorptionAbsorption

1375

  200

125

1375

  200

125
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Accounting Flows: Costs Incurred,
Outside Processing

Accounting Flows: Costs Incurred,
Outside Processing

Example
• You are a shop floor production worker for Vision.

In your job, you receive assemblies on workorders
from outside suppliers and subcontractors,
charging outside processing resources to jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor outside processing (OSP)
resource transactions:
– OSP resource transaction without rate variance
– OSP resource transaction reversal
– Resource overhead on OSP resource

Example
• You are a shop floor production worker for Vision.

In your job, you receive assemblies on workorders
from outside suppliers and subcontractors,
charging outside processing resources to jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor outside processing (OSP)
resource transactions:
– OSP resource transaction without rate variance
– OSP resource transaction reversal
– Resource overhead on OSP resource
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Accounting Flows: Costs Incurred,
Outside Processing

Accounting Flows: Costs Incurred,
Outside Processing

Recording T Accounts for Transactions (on the next page)
10. Shop floor transaction

(OSP resource without rate variance)
Charge OSP OS1 at actual for operation 30.
Receive 11 units at $25 = $275.

11. Shop floor transaction
(reverse OSP charge)
Reverse overcharge.
1 unit at $25 = $25.

12. Shop floor transaction
(resource overhead on OSP resource)
Charge overhead at 1 unit at $20.

Recording T Accounts for Transactions (on the next page)
10. Shop floor transaction

(OSP resource without rate variance)
Charge OSP OS1 at actual for operation 30.
Receive 11 units at $25 = $275.

11. Shop floor transaction
(reverse OSP charge)
Reverse overcharge.
1 unit at $25 = $25.

12. Shop floor transaction
(resource overhead on OSP resource)
Charge overhead at 1 unit at $20.



Copyright © Oracle Corporation, 2000. All rights reserved.

Appendix B: Describing T-Accounts for WIP Transactions for Standard Costing
Chapter 4 - Page 18

Accounting Flows: Costs Incurred, Outside Processing

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Accounting Flows: Costs Incurred,
Outside Processing

Accounting Flows: Costs Incurred,
Outside Processing

Outside processing transactions record the external
cost to convert raw material into finished assemblies.
10. Shop floor transaction (OSP)
11. Shop floor transaction (reverse OSP charge)
12. Shop floor transaction (resource overhead on OSP)

Outside processing transactions record the external
cost to convert raw material into finished assemblies.
10. Shop floor transaction (OSP)
11. Shop floor transaction (reverse OSP charge)
12. Shop floor transaction (resource overhead on OSP)

Outside Processing TransactionsOutside Processing Transactions

10

11

12

275

 25

100

WIPWIP
AccountsAccounts

ReceivingReceiving
InspectionInspection

PurchasePurchase
PricePrice Var Var

InventoryInventory
AP AccrualAP Accrual

20

275

100

25

275

  20

275

 2525

Note
The Organization Receiving Inspection account is used as the absorption
account for outside processing subelements. The Purchase Price Variance
account is the variance account for the outside processing resource being
charged.
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Completion and Scrap
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Accounting Flows: Costs Relieved,
Assembly Completion and Scrap

Accounting Flows: Costs Relieved,
Assembly Completion and Scrap

Example
• You are an assembler and a tester on a

subassembly production line for Vision. In your job,
you scrap defective assemblies and complete good
assemblies on workorders.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor scrap transactions and WIP
completion transaction:
– Scrap transaction
– Scrap transaction reversal
– WIP completion transaction

Example
• You are an assembler and a tester on a

subassembly production line for Vision. In your job,
you scrap defective assemblies and complete good
assemblies on workorders.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor scrap transactions and WIP
completion transaction:
– Scrap transaction
– Scrap transaction reversal
– WIP completion transaction
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Accounting Flows: Costs Relieved, Assembly
Completion and Scrap
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Accounting Flows: Costs Relieved,
Assembly Completion and Scrap

Accounting Flows: Costs Relieved,
Assembly Completion and Scrap

Recording T Accounts for Transactions (on the next page)
13. Shop floor transaction

 Scrap two assemblies at operation 40.
 2 units at $467 = $934.

14. Shop floor transaction
 Return repaired unit from scrap.
 1 unit at $467.

15. WIP completion transaction
 Complete nine assemblies from WIP to inventory.
 9 units at $467 = $4203 + 9 units at $20 for material

      overhead.

Recording T Accounts for Transactions (on the next page)
13. Shop floor transaction

 Scrap two assemblies at operation 40.
 2 units at $467 = $934.

14. Shop floor transaction
 Return repaired unit from scrap.
 1 unit at $467.

15. WIP completion transaction
 Complete nine assemblies from WIP to inventory.
 9 units at $467 = $4203 + 9 units at $20 for material

      overhead.
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Accounting Flows: Costs Relieved,
Assembly Completion and Scrap

Accounting Flows: Costs Relieved,
Assembly Completion and Scrap

• You relieve costs from WIP when you complete
assemblies to inventory or scrap assemblies at an
operation.

• Completion and scrap transactions relieve costs
from WIP on a this-level basis and on a previous-
level basis.

• You relieve costs from WIP when you complete
assemblies to inventory or scrap assemblies at an
operation.

• Completion and scrap transactions relieve costs
from WIP on a this-level basis and on a previous-
level basis.

Completion and Scrap TransactionsCompletion and Scrap Transactions

13

14

15

   934

4,383

SubinventorySubinventory
AccountsAccounts

WIPWIP
AccountsAccounts

Material OHMaterial OH
AbsorptionAbsorption

ScrapScrap
AccountAccount

180 467

934

4,383

467
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Accounting Flows: VariancesAccounting Flows: Variances

Example
• You are a production line supervisor for Vision. In

your job, you close workorders that are complete
and analyze variances.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following job close transaction:
– Job close transaction

Example
• You are a production line supervisor for Vision. In

your job, you close workorders that are complete
and analyze variances.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following job close transaction:
– Job close transaction
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Accounting Flows: VariancesAccounting Flows: Variances

Recording T Accounts for Transactions
16. Job close or schedule
 Recognize this-level variances and previous-level

variances.

Recording T Accounts for Transactions
16. Job close or schedule
 Recognize this-level variances and previous-level

variances.
Job CloseJob Close

16

SubinventorySubinventory
AccountsAccounts

WIPWIP
AccountsAccounts

Material OHMaterial OH
AbsorptionAbsorption

VarianceVariance
AccountsAccounts

289289
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SummarySummary

In this lesson, you should have learned how to:
• Describe T-Accounts for WIP transactions in

standard costing

In this lesson, you should have learned how to:
• Describe T-Accounts for WIP transactions in

standard costing

Note: This is an example of a summary slide that includes the
objectives that were stated earlier.
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Practice 2 OverviewPractice 2 Overview

This practice covers the following topics:
• Recording postings for manufacturing

transactions in a standard costing environment

This practice covers the following topics:
• Recording postings for manufacturing

transactions in a standard costing environment
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Practice 2-1: Recording Postings for
Standard Costing Transactions

Practice 2-1: Recording Postings for
Standard Costing Transactions

In this practice, you record postings for a variety of
manufacturing transactions.
• You are an assembler on a subassembly

production line. After performing a variety of
manufacturing transactions to complete a
workorder to produce ten loaded boards, you look
at the postings of these transactions.

In this practice, you record postings for a variety of
manufacturing transactions.
• You are an assembler on a subassembly

production line. After performing a variety of
manufacturing transactions to complete a
workorder to produce ten loaded boards, you look
at the postings of these transactions.
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Practice 2-1: Recording Postings for
Standard Costing Transactions

• Aftering opening a workorder, you issue material
(push components), charge in-house resources,
and charge outside processing resources as you
convert unloaded boards into finished boards.

• When you complete the workorder, you perform
WIP completions to move the finished boards from
WIP to Inventory. Then you close the workorder
and record variances to remove the residual
charges in WIP.

• Aftering opening a workorder, you issue material
(push components), charge in-house resources,
and charge outside processing resources as you
convert unloaded boards into finished boards.

• When you complete the workorder, you perform
WIP completions to move the finished boards from
WIP to Inventory. Then you close the workorder
and record variances to remove the residual
charges in WIP.
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Practice 2-1: Recording Postings for
Standard Costing Transactions

After opening the workorder, you do the following:
1.  Issue material (push components) at standard cost

into the job.
     10 units at $300 = $3,000.
2.  Charge resources without rate variance.

10 units at $20 = $200.
3.  Charge outside processing resources without rate

variance.
10 units at $10 = $100.

4.  Charge resource-based overhead at 250% on the
resource charged in step 2.

     200.00 * 250% = $50.
5.  Complete ten units to inventory.

10 at $350 = $3,500.
6.  Close the job and post the variances.

After opening the workorder, you do the following:
1.  Issue material (push components) at standard cost

into the job.
     10 units at $300 = $3,000.
2.  Charge resources without rate variance.

10 units at $20 = $200.
3.  Charge outside processing resources without rate

variance.
10 units at $10 = $100.

4.  Charge resource-based overhead at 250% on the
resource charged in step 2.

     200.00 * 250% = $50.
5.  Complete ten units to inventory.

10 at $350 = $3,500.
6.  Close the job and post the variances.
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Practice 2-1: Recording Postings for
Standard Costing Transactions

Subinventory Subinventory 
AccountsAccounts

OverheadOverhead
AbsorptionAbsorption

11
22
33
44
55
66

InventoryInventory
AP AccrualAP Accrual

WIP  WIP  
AccountsAccounts

Resource Resource 
AbsorptionAbsorption

Receiving  Receiving  
InspectionInspection

11
22
33
44
55
66
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Practice 2-1: Recording Postings for
Standard Costing Transactions

Subinventory Subinventory 
AccountsAccounts

OverheadOverhead
AbsorptionAbsorption

11
22
33
44
5       3500                        35005       3500                        3500
66     300    300

30003000     30003000
             200             200
             100             100
             500             500

InventoryInventory
AP AccrualAP Accrual

WIP  WIP  
AccountsAccounts

Resource Resource 
AbsorptionAbsorption

Receiving  Receiving  
InspectionInspection

200200
             100             100
                          

11
22
33    100   100
44         500        500
55
66

VarianceVariance
AccountsAccounts

500500
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